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Introduction  

This tutorial teaches you how to convert the DDS screens in an existing 5250 order 

entry application to a Web browser user interface. While creating a browser user 

interface, you will learn how to use the IBM® WebFacing Tool. You will also learn 

how to customize the output of the conversion process using the IBM WebFacing 

Tool and the CODE Designer. Next, you will learn how to run the WebFacing 

application in the WebSphere® Test Environment that is part of the product. You 

will also learn how to use Page Designer to customize the application start page 

and you will learn how to publish and deploy your WebFacing application to a 

remote WebSphere Application Server (this is an optional module). 

Prerequisites 

In order to complete this tutorial end to end, you should already have working 

knowledge of the following: 

v   Basic Microsoft® Windows® operations such as working with the desktop and 

basic mouse operations such as opening folders and performing drag-and-drop 

operations 

v   How Web applications work 

v   How to use a browser to navigate the Internet

It  is also useful, but not necessary, for you to have basic knowledge of the 

following: 

v   DDS 

v   Servlets and Java™ Server Pages (to understand the generated output of the 

WebFacing Tool)

Time required 

To complete the modules of this tutorial, you will need approximately 2 hours and 

20 minutes. 

Learning objectives 

This tutorial is divided into twelve modules, each with its own learning objectives. 

You can choose to complete one or all of the modules. Each module contains 

several exercises that must be completed in order for the tutorial to work properly. 

Chapter 1, “Module 1. Reviewing the 5250 order entry application,” on page 1 

teaches you about the 5250 order entry application before you start and use the 

WebFacing Tool to convert it. In this module, you will: 

v   Start a 5250 emulation session 

v   Call the order entry application 

v   View the customer selection screen 

v   Display help for the customer number field 

v   Display help for selecting a customer 

v   Display help for specifying a valid customer number 

v   Display extended help for the customer number field 

v   Display the customer selection list 
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v   Select a customer from the list 

v   Display the parts selection list 

v   Select a part from the list 

v   Specify the part quantity 

v   Accept the order 

v   Exit the application

Chapter 2, “Module 2. Creating the WebFacing project,” on page 9 teaches you 

how to create a WebFacing project. In this module, you will: 

v   Start the product 

v   Set the default workspace 

v   Access unique views and tools targeted towards the WebFacing tasks 

v   Specify a name for your WebFacing Web Project 

v   Connect to an iSeries server 

v   Select DDS source members to convert 

v   Select UIM source members to convert 

v   Specify the CL command to invoke the application 

v   Specify the application signon values 

v   Select a Web style for your converted application 

v   Create the WebFacing Web Project without converting files

Chapter 3, “Module 3. Converting selected source members,” on page 27 teaches 

you how to convert one or more DDS and UIM files. In this module, you will: 

v   Select members to convert 

v   Convert members 

v   Check reference keywords for errors 

v   Check the DSPF conversion log for errors 

v   Check the UIM conversion log for errors

Chapter 4, “Module 4. Running the WebFacing application,” on page 33 teaches 

you how to run the Web application in the WebSphere Test Environment. In this 

module, you will: 

v   Set the WebSphere Test Environment to test the application locally 

v   Launch the WebFacing application 

v   Prompt for a customer 

v   Select a customer from a list of customers 

v   Prompt for a part 

v   Select a part from a list of parts 

v   Enter a quantity for a part 

v   Display help for the customer selection list

Chapter 5, “Module 5. Changing the user interface,” on page 41 teaches you how 

to change certain aspects of the user interface related to the conversion process. In 

this module, you will: 

v   Locate a DDS source member 

v   Open a DDS source member with CODE Designer 

v   Create a hyperlink action for the option field 

v   Hide the option field 
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v   Hide the option heading for the option field 

v   Hide the select instruction 

v   Change the appearance of text 

v   Close CODE Designer 

v   Reconvert the DDS source member 

v   Launch the reconverted WebFacing application 

v   Prompt for a customer 

v   Verify the changes in the customer selection window

Chapter 6, “Module 6. Changing the style of the Web user interface,” on page 51 

teaches you how to create a new style, change style settings, specify the new style 

to be used for the project and refresh the project with the new style. In this 

module, you will: 

v   Start the Style Properties dialog 

v   Change the DDS Field Display Attributes 

v   Locate the cascading style sheet file 

v   Edit the cascading style sheet file 

v   Check the new styles

Chapter 7, “Module 7. Adding command key rules and labels,” on page 61 teaches 

you how to add your own command key recognition rules to the WebFacing 

conversion properties. In this module, you will: 

v   Start the Properties dialog 

v   Select Command Key Recognition Patterns 

v   Add a new command key rule 

v   Reconvert the DDS members 

v   Test the applied new rule 

v   Change the text for the F12 command key 

v   Reconvert the DDS members 

v   Test the new command key label

Chapter 8, “Module 8. Working with more style properties,” on page 69 teaches 

you how to apply changes to windows, the look of push buttons, and subfiles. In 

this module, you will: 

v   Start the Properties dialog 

v   Change the window style 

v   Change the subfile style 

v   Change the command key style 

v   Test the changed properties

Chapter 9, “Module 9. Customizing the default style,” on page 77 teaches you how 

to customize that style, updating the look and feel for a fictional company. In this 

module, you will: 

v   Locate the existing style 

v   View the design of the existing style 

v   Import the company logo 

v   Edit the style sheet to include the company logo 

v   Edit PageBuilder.jsp to remove and resize fields for your logo 
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v   Change the color

Chapter 10, “Module 10. Adding authentication,” on page 83 teaches you how to 

secure your application by forcing authentication before the application is called. In 

this module, you will: 

v   Start the Properties dialog 

v   Open the project run-time properties 

v   Change the signon properties for the order entry application 

v   Test the signon dialog appears

Chapter 11, “Module 11. Enhancing index.jsp page,” on page 87 teaches you how 

to take the plain index.jsp page generated by the WebFacing Tool and add color 

and some pictures to make the input page of the Web application more interesting. 

In this module, you will: 

v   Open index.jsp in Page Designer 

v   Change the window title to Order Entry 

v   Add a style to the Order Entry Web page 

v   Start WebArt Designer 

v   Add a logo 

v   Resize the logo 

v   Save the logo as a WebArt object 

v   Save the logo for a Web page 

v   Place the logo on the Design page 

v   Insert a heading below the logo 

v   Add a picture to the Order Entry Web page 

v   Add a marquee to the Order Entry Web page 

v   Change the color of the window title 

v   Remove default text added by the WebFacing Tool

Chapter 12, “Module 12. (Optional) Exporting to iSeries WebSphere Application 

Server Express 5.1,” on page 111  teaches you how to export files created by the 

WebFacing Tool to a remote WebSphere Application Server, to publish and deploy 

your application as you would when your application is ready for production. In 

this module, you will: 

v   Map  a network drive 

v   Open the Export wizard 

v   Export the EAR file 

v   Start an existing HTTP server console

When you are ready, begin Chapter 1, “Module 1. Reviewing the 5250 order entry 

application,” on page 1. 
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Chapter  1.  Module  1.  Reviewing  the  5250  order  entry  

application  

This module teaches you how the existing application green screens, command 

keys and help panels work and look before you start using the WebFacing Tool to 

convert it. You will become familiar with the 5250 screens and the behavior of the 

application so that after conversion with the WebFacing Tool you will then be able 

to compare the 5250 and the Web user interface. 

Completing this module will also test your user profile setup. If you can run this 

application directly without changing the job environment on the iSeries™, the 

WebFacing conversion and the WebFacing server will not have problems during 

the remaining exercises later. 

You will use a 5250 emulation screen to start the sample Order Entry application. 

You will be prompted with the first screen for a customer number. You will work 

with the help panels this application provides. You will select a customer from the 

list of valid customers and then go through the steps of filling an order by 

specifying the quantity ordered. After all parts and their quantities for this order 

have been specified you complete the order by pressing a specific command key. 

The application will then prompt you for a new customer number to handle the 

next order. 

Note:  If you have problems make sure the library list for your job is setup 

correctly to include library WFLABXX at job start up. 

In this module, you will: 

v   Start a 5250 emulation session 

v   Call the order entry application 

v   View the customer selection screen 

v   Display help for the customer number field 

v   Display help for selecting a customer 

v   Display help for specifying a valid customer number 

v   Display extended help for the customer number field 

v   Display the customer selection list 

v   Select a customer from the list 

v   Display the parts selection list 

v   Select a part from the list 

v   Specify the part quantity 

v   Accept the order 

v   Exit the application

Exercises 

The exercises within this module must be completed in order: 

v   “Exercise 1.1: Starting the 5250 application” on page 2 

v   “Exercise 1.2: Accessing the online help” on page 2 

v   “Exercise 1.3: Selecting a customer” on page 4 
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v   “Exercise 1.4: Filling the order” on page 6 

v   “Exercise 1.5: Completing the order” on page 7

Time  required 

This module will take approximately 5 minutes to complete. 

Exercise 1.1: Starting the 5250 application 

You need a 5250 emulator on your workstation to start the order entry application. 

To start the 5250 application: 

1.   Start a 5250 emulation session. 

2.   In the User ID field, type your user ID. 

3.   In the Password field, type your password. 

4.   On the command line of the 5250 screen, invoke the Order Entry Application: 

CALL ORDENTR 

The application starts and shows the first panel. This first screen prompts for a 

customer number. You have a choice of keying in the customer number directly 

or you can press command key F4 to display a list of existing customers.
  

 

You have started a 5250 emulation session, invoked the order entry application and 

seen the customer selection screen and now you are ready to begin “Exercise 1.2: 

Accessing the online help.” 

Exercise 1.2: Accessing the online help 

Before you begin, you must complete “Exercise 1.1: Starting the 5250 application.” 

Before you go ahead with the order entry process, try the help. This application 

uses User Interface Manager (UIM) help. You will also convert these UIM help 

panels with the WebFacing Tool. To understand the results of the UIM help 

conversion, try the help in the 5250 environment and then later in the browser. 

1.   Move the cursor to the Customer number field. 

2.   Press command key F1.  

Panel group help displays for the customer number. 
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3.   To see more help, move the cursor underneath the 1 in the help area and press 

the Enter key. 

Help for requesting a customer list displays.
  

  

4.   Press command key F12 to return to the help for the Customer number field. 

5.   To see help for the second choice, move the cursor underneath the 2 in the help 

area and press the Enter key. 

Now you see detailed help for specifying a valid customer number. 
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6.   Press command key F12 to leave the help for the Customer number field. 

The main help panel in the Select customer – Help area shows. 

7.   Press command key F2 to get to the extended help. 

Here you see the extended help for the Customer number field. 

  

  

8.   Press command key F12 to leave the extended help for the Customer number 

field. 

9.   Press command key F12 again to leave the help for the Customer number field. 

You have displayed help for the customer number field, for selecting a customer, 

for specifying a valid customer number and extended help for the customer 

number field and now you are ready to begin “Exercise 1.3: Selecting a customer.” 

Exercise 1.3: Selecting a customer 

Before you begin, you must complete “Exercise 1.2: Accessing the online help” on 

page 2. 
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Now you have an understanding how the help panels in this application work and 

look. Next you need to identify the customer related order. You have the choice of 

specifying a valid customer number, or you can get a selection list of valid 

customers. Use the selection list because it shows a record format that uses the 

WINDOW DDS keyword and so you can see how the WebFacing Tool converts a 

DDS window. 

1.   Press command key F4 to display the customer selection list. 

A list of customers displays.
  

  

2.   In the Options field, type 1 to select a customer. 

3.   Press the Enter key to proceed. 

This returns you to the initial panel now filled with detailed data for the 

selected customer. 

  

 

You’ll notice that an order number has been assigned as well. You are ready to 

order some parts.

You have displayed the customer selection list and selected a customer from the 

list and now you are ready to begin “Exercise 1.4: Filling the order” on page 6. 

 

Chapter  1. Module  1. Reviewing  the  5250 order  entry application 5



Exercise 1.4: Filling the order 

Before you begin, you must complete “Exercise 1.3: Selecting a customer” on page 

4. 

The process of selecting parts is similar to the way you selected a customer in the 

previous exercise. You are able to key in the part number directly or select the part 

from a selection list. Next you want to work with the parts selection list. 

On the order entry panel: 

1.   Press command key F4 to see a list of available parts. 

The Select Part panel opens.
  

  

2.   In the Options field, type 1 next to a part that has lots of quantity left. 

Back on the order screen, the part appears in the order; on the top line of the 

parts list.
  

 

Next you order a certain quantity of this part. 

3.   Change the Qty field to a value, for example 2. 

4.   Press the Enter key to add the part and quantity ordered to the order. 
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The detail order line for this part, with the quantity specified, is now part of 

this order.
  

 

Add more parts until your order is complete. 

5.   Press command key F4 to see a list of available parts. 

6.   Select a part from the parts list and press Enter. 

7.   Specify the part quantity and press Enter. 

You have displayed the parts selection list, selected a part from the list and 

specified the part quantity and now you are ready to begin “Exercise 1.5: 

Completing the order.” 

Exercise 1.5: Completing the order 

Before you begin, you must complete “Exercise 1.4: Filling the order” on page 6. 

Now you are ready to accept the order. You use the Order Entry panel to complete 

the order. 

To complete the order: 

1.   Press command key F6 to accept the order. 

The order is added to the database and the next order can be filled. You return 

to the starting screen of the application. 

You have worked with all panels in this application: 

v   The start order entry panel 

v   Several help panels 

v   The customer list window 

v   The full order entry panel 

v   The parts list window

You can add more orders but if you understand how the user interface of this 

application works, stop adding orders. 

2.   Press command key F3 to exit the application. 

You are now ready to put a brand new user interface onto this application.

You  have accepted the order and exited the application. 
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Module recap 

You have completed Chapter 1, “Module 1. Reviewing the 5250 order entry 

application,” on page 1. You have learned how to: 

v   Start a 5250 emulation session 

v   Call the order entry application 

v   View the customer selection screen 

v   Display help for the customer number field 

v   Display help for selecting a customer 

v   Display help for specifying a valid customer number 

v   Display extended help for the customer number field 

v   Display the customer selection list 

v   Select a customer from the list 

v   Display the parts selection list 

v   Select a part from the list 

v   Specify the part quantity 

v   Accept the order 

v   Exit the application

Now that you know how the order entry application green screens, command keys 

and help panels work and look, you can continue to Chapter 2, “Module 2. 

Creating the WebFacing project,” on page 9. 
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Chapter  2.  Module  2.  Creating  the  WebFacing  project  

Before you can use the WebFacing Tool to reface your application you need to 

create a WebFacing project in the workbench. The first step when starting with the 

WebFacing Tool is to create a WebFacing project. You will identify the project 

information, like the DDS source member names to be converted using the 

WebFacing Tool, and they will be stored in a workspace on your workstation. You 

will proceed through the process of identifying the DDS and UIM Panel Group 

source members to be converted by the WebFacing Tool and specify some of the 

runtime information you will need later when running the WebFacing application. 

This module teaches you how to create a WebFacing project, something that you 

need before you can create a Web user interface for the Order Entry Application. 

You will then learn how to use this WebFacing project to facilitate the conversion 

of your DDS source and to test the generated output. 

In this module, you will: 

v   Start the product 

v   Set the default workspace 

v   Access unique views and tools targeted towards the WebFacing tasks 

v   Specify a name for your WebFacing Web Project 

v   Connect to an iSeries server 

v   Select DDS source members to convert 

v   Select UIM source members to convert 

v   Specify the CL command to invoke the application 

v   Specify the application signon values 

v   Select a Web style for your converted application 

v   Create the WebFacing Web Project without converting files

Exercises 

The exercises within this module must be completed in order: 

v   “Exercise 2.1: Starting the product” on page 10 

v   “Exercise 2.2: Opening the WebFacing perspective” on page 11 

v   “Exercise 2.3: Starting the WebFacing Web Project wizard” on page 12 

v   “Exercise 2.4: Selecting display file members to convert” on page 14 

v   “Exercise 2.5: Specifying the CL command to launch the application” on page 20 

v   “Exercise 2.6: Selecting a Web style” on page 22 

v   “Exercise 2.7: Completing the WebFacing project information” on page 22

Time  required 

This module will take approximately 25 minutes to complete. 
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Exercise 2.1: Starting the product 

Now go ahead and start the product. 

To start the product: 

1.   On the desktop task bar click Start > All Programs > IBM WebSphere Studio 

> Development Studio Client for iSeries 5.1.2.
  

 

A dialog appears asking you for the workspace location, unless you used the 

product before and selected not to show this dialog again. 

The workspace contains all the information about your Development Studio 

projects. You can accept the default or store the work related to this tutorial in 

a separate workspace. You can always start with a new workspace later, if you 

don’t want to mix these exercise WebFacing projects with your real work. 

  

  

2.   Accept the default directory structure but change the name of the workspace 

directory to the name WFLABxx where XX is a unique number. 

3.   Click OK. 

After a few moments of loading, the workbench opens, and the initial window 

of the product opens.
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Note:  If you didn’t reset the workspace, or you are working with the standard 

version of the product, your environment will differ slightly from the 

screen captures in this tutorial.

You  have started the product and set the default workspace and now you are 

ready to begin “Exercise 2.2: Opening the WebFacing perspective.” 

Exercise 2.2: Opening the WebFacing  perspective 

Before you begin, you must complete “Exercise 2.1: Starting the product” on page 

10. 

The workbench shows the Remote System Explorer (RSE) perspective by default. 

This is the perspective that you would use to work with iSeries objects. It allows 

specifying connections to iSeries servers and provides for the programmer a 

similar interface to iSeries objects as the Program Development Manager (PDM) 

does in a green screen environment. 

The WebFacing Tool provides it’s own perspective since it needs to give its users 

access to unique views and tools targeted towards the WebFacing task. To create a 

WebFacing project you first need to open the WebFacing perspective. 

To open a WebFacing perspective:
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1.   Click Window > Open Perspective > WebFacing from the workbench menu. 

The workbench now shows the WebFacing perspective with the WebFacing 

Projects view open in the left pane of the workbench.
  

 

You are ready to start the WebFacing project wizard to create a WebFacing 

project.

You have accessed unique views and tools targeted towards the WebFacing tasks 

through the WebFacing perspective and now you are ready to begin “Exercise 2.3: 

Starting the WebFacing Web Project wizard.” 

Exercise 2.3: Starting the WebFacing  Web  Project wizard 

Before you begin, you must complete “Exercise 2.2: Opening the WebFacing 

perspective” on page 11. 

A WebFacing project is a complete Web project with the directory structure and 

files needed to conform to the Java 2 platform, Enterprise Edition (J2EE) standard 

of a Web application. It also contains additional information unique to WebFacing, 

like the source to be converted. 
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To start the WebFacing Web Project wizard: 

1.   In the WebFacing perspective, click File > New > WebFacing Web Project from 

the workbench menu.
  

 

This will start the WebFacing Web Project wizard. 

2.   In the WebFacing Web Project wizard you will be presented with the 

WebFacing Web Project page. 

  

  

3.   In the Project name field, type the project name wflabxx where XX is a unique 

number. 

The Enterprise Archive (EAR project) File will be updated automatically. 

This will create a unique Application file for this WebFacing project. 

4.   Click Next. 

The Select Display File Source Members to Convert page opens.
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You have specified a name for your WebFacing Web Project and now you are 

ready to begin “Exercise 2.4: Selecting display file members to convert.” 

Exercise 2.4: Selecting display file members to convert 

Before you begin, you must complete “Exercise 2.3: Starting the WebFacing Web 

Project wizard” on page 12. 

On this second page of the WebFacing project wizard you need to specify the 

name of the iSeries server that contains your display file DDS source, as well as 

which members of the source file you want to convert. Specifically, the WebFacing 

Tool needs to know these names: 

v   Server name 

v   Library name 

v   Source file name 

v   Member name

Note:  You need to identify members for all record formats used in your 

application. If you miss one and at runtime the record format gets 

requested, your end user will get a Page not found error. 

First since you are starting with a new workspace, you need to specify the iSeries 

server name to specify where the Data Description Source (DDS) is located. 
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Connecting to an iSeries 

To connect to an iSeries: 

 1.    Click New beside the Connection list.
  

 

The Name personal profile page opens.
  

  

 2.   Accept the default profile name as this is your own private connection. 

 3.   Click Next. 

The Remote iSeries System Connection page opens.
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4.   In the Host name field, type the name of the host system, for example s400a.

Note:  This is your iSeries server name; don’t use the one shown unless your 

system is named s400a. 

The connection name will be filled automatically with the same value. 

 5.   Leave the Verify host name check box selected to verify that the host name or 

IP address exists. 

 6.   Click Finish. 

The connection is created and can be re-used by all tools in the workbench. 

The connection wizard also checks whether the iSeries host can be reached 

and if this test is successfully completed, you return to the Select Display File 

Source Members to Convert page. 

 7.   Check that your iSeries server is selected in the Connection list.
  

  

 8.   Make sure that *LIBL is selected in the Library list. 

 9.   Click Refresh DDS list.
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A User ID and password dialog opens.
  

  

10.   In the User ID field, type your user ID. Use the same user ID that you used 

when running the Order Entry application in Chapter 1, “Module 1. 

Reviewing the 5250 order entry application,” on page 1. 

11.   In the Password field, type your password. 

12.   Select the Save user ID check box. 

13.   Select the Save password check box. 

14.   Click OK. 

A connection to the iSeries server gets established. The library list of your 

iSeries job is displayed under the Refresh DDS list button on the Select 

Display File Source Members to Convert page.
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Selecting DDS source members 

To select DDS members to convert: 

1.   Select the WFLABXX library from the list. 

2.   Click the plus sign (+) beside the WFLABXX library to expand it.
  

  

3.   Select the QDDSSRC source file from the expanded list. 

4.   Expand QDDSSRC and select all members from the list. 
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5.   Click 

   

push button in the middle of the page to copy the selected 

members over to the list of members to be converted at the right. 

Tip: To move all members in a source file you can select the source file icon 

itself and click the 

   

push button. This will add all members in a source 

file to the list of members to be converted. 

The WebFacing Tool now knows which DDS members to convert for this 

project. The conversion hasn’t been done but the information is stored for 

future use. 

Next you convert UIM source members.

Selecting UIM source members 

To select UIM source members to convert: 

1.   Click Next to proceed to the next page of the wizard. 

The Select UIM Source Members to Convert page opens.
  

 

Now you have to identify the panel group source containing the help 

information for the Order Entry application. 

2.   Click Refresh UIM list push button. 

3.   Expand library WFLABXX. 

4.   Select the QPNLSRC source file from the expanded list of library WFLABXX. 

5.   Click 

   

push button in the middle of the page to copy all members over 

to the list of members to be converted at the right. 
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There is actually only one panel group member ORDENTRPNL in this source 

file. 

6.   Click Next to proceed to the next page of the wizard. 

The Specify CL Commands page opens.

You have connected to an iSeries server, selected DDS source members and UIM 

source members to convert and now you are ready to begin “Exercise 2.5: 

Specifying the CL command to launch the application.” 

Exercise 2.5: Specifying the CL command to launch the application 

Before you begin, you must complete “Exercise 2.4: Selecting display file members 

to convert” on page 14. 

You will now provide the information that will allow the WebFacing Web Project 

wizard to create the initial index.jsp page to start the Order Entry application. Do 

you remember what you typed on the command line to start the Order Entry 

application in the 5250 emulation session during the first exercise in Chapter 1, 

“Module 1. Reviewing the 5250 order entry application,” on page 1? In case you 

forgot; it was: CALL ORDENTR 

Why  should you remember? The WebFacing run time needs to know the 

invocation command for your application in order to send this invocation 

command to the iSeries server to start your application from the browser. The page 

in the WebFacing Web Project wizard will allow you to specify the necessary 

information CL command and Sign on information.
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To specify the CL commands: 

1.   In the CL command field, type CALL ORDENTR 

2.   In the Command Label field, type Order Entry Application. 

Note:  If you don’t type anything into the Command Label field, the CL 

command input will be copied into this field. 

3.   Leave the default value INV1 in the Invocation name field. 

4.   Click the Specify OS/400 signon values radio button. 

This will automatically apply the user ID and password you used when you 

connected to your iSeries server in the previous dialog for selecting source 

members for invocation of this application. You will use this setup here for 

testing purposes to make it easier for you to start the Order Entry application 

without specifying the authentication information. Don’t worry about security 

in your production environment, this can be easily changed later and you will 

see how to do this later in this tutorial. 

5.   Click Add on the right side of the page. 

Note:  Make sure the text and command you typed into the fields are actually 

shown in the CL Command table at the bottom of the page. 

6.   Click Next at the bottom of the wizard page. 

The Choose a Web Style page opens.
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You have specified a CL command to invoke the application and the application 

signon values and now you are ready to begin “Exercise 2.6: Selecting a Web 

style.” 

Exercise 2.6: Selecting a Web  style 

Before you begin, you must complete “Exercise 2.5: Specifying the CL command to 

launch the application” on page 20. 

Next you select a Web style for your converted screens. 

To select a Web style:
  

  

1.   Select the gradient style from the list of available styles. 

2.   Click Next. 

The Completing WebFacing Project page opens.

You have selected a Web style for your converted application and now you are 

ready to begin “Exercise 2.7: Completing the WebFacing project information.” 

Exercise 2.7: Completing the WebFacing  project information 

Before you begin, you must complete “Exercise 2.6: Selecting a Web style.” 
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On this page you have choice of creating the project and converting the source in 

one step or only creating the WebFacing project. 

You will just create the WebFacing project. You don’t need to convert the source 

now. Conversion is part of the next module. 

  

 

To complete the WebFacing project information: 

1.   Select the No. I only want to create the project now radio button. 

2.   Click Finish. 

The WebFacing project is created. The workbench opens in the WebFacing 

perspective with your new WebFacing project in the WebFacing Projects view.
  

 

Ignore the warnings that you see in the Tasks view. These warnings are fixed at 

runtime.
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Notice that the WebFacing project icon indicates which J2EE level will be used 

for the project. 

If you expand the wflabxx project you’ll notice several files and folders have 

been added to this WebFacing project: 

v   The information for display file source members to be converted 

v   The information for panel group source members to be converted 

v   The CL Command that will be used to start the Order Entry application 

v   The style to be used for the converted screens. 

When you expand the folders and files under your WebFacing project you can 

see the information that is captured for this project.
  

  

3.   Click each folder or file. Click the plus + sign beside each file or folder. 

Tip: If you later need to add source members to the WebFacing project, 

right-click the DDS or UIM help icon and click Add on the pop-up menu. This 

will launch the WebFacing Web Project wizard and display the correct dialog.
  

 

You have created the WebFacing Web Project without converting files. 
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Module recap 

You have completed Chapter 2, “Module 2. Creating the WebFacing project,” on 

page 9. You have learned how to: 

v   Start the product 

v   Set the default workspace 

v   Access unique views and tools targeted towards the WebFacing tasks 

v   Specify a name for your WebFacing Web Project 

v   Connect to an iSeries server 

v   Select DDS source members to convert 

v   Select UIM source members to convert 

v   Specify the CL command to invoke the application 

v   Specify the application signon values 

v   Select a Web style for your converted application 

v   Create the WebFacing Web Project without converting files

You have created a WebFacing project and in this project you specified which 

display file source and panel group source to convert and which iSeries server 

these source members are located on. The WebFacing Tool will use this information 

during the conversion process. You have to specify in this next module whether 

you want to convert all source members belonging to this project or selected ones 

only. A word regarding security, in case you are wondering, why you don’t have to 

logon to the iSeries server during conversion. Your user ID and password have 

been stored during the WebFacing project setup and will be re-used here. Continue 

to Chapter 3, “Module 3. Converting selected source members,” on page 27. 
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Chapter  3.  Module  3.  Converting  selected  source  members  

This module teaches you how the WebFacing conversion creates the JSP files for 

the browser User Interface description, XML  files for record format layouts, and 

several other files needed for the Web application. You will learn how to select the 

convert option, start the conversion and work with the conversion logs to check 

the results of the WebFacing conversion. 

In this module, you will: 

v   Select members to convert 

v   Convert members 

v   Check reference keywords for errors 

v   Check the DSPF conversion log for errors 

v   Check the UIM conversion log for errors

Exercises 

The exercises within this module must be completed in order: 

v   “Exercise 3.1: Selecting the project and source members” 

v   “Exercise 3.2: Starting the WebFacing conversion” on page 29 

v   “Exercise 3.3: Checking the conversion logs” on page 31

Time  required 

This module will take approximately 10 minutes to complete. 

Exercise 3.1: Selecting the project and source members 

You will use the product to do the WebFacing conversion, if it is not up and 

running already, start it now. If it is still up and running on your workstation you 

are ready to go ahead. 

If the WebFacing perspective with your project is not visible, you need to open the 

WebFacing perspective. 

Opening the WebFacing perspective 

To open the WebFacing perspective: 

1.   Check the taskbar of the workbench for the WebFacing perspective icon and if 

you find it, click on the icon to switch to the WebFacing perspective that is 

already open but not active at the moment. 

Tip: Avoid having too many instances of the same perspective open. It will 

improve performance of the workbench if you restrict yourself to one instance 

of a specific perspective being open. We have seen situations with 50 

perspectives being open at the same time; this has caused severe performance 

impacts, so be careful. 

Here you see the icons on the taskbar of the workbench. The Remote System 

Explorer perspective is active. The workbench window title bar shows this. 

Four perspectives are open in the workbench. 
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v   

   

The WebFacing perspective 

v   

  

The Remote System Explorer perspective 

v   

  

The Java perspective 

v   

  

The Web perspective

2.   To switch to the WebFacing perspective. Select its icon 

   

from the taskbar. 

Tip: The icon 

   

on top of the taskbar allows you to open a new perspective. 

Next you start the conversion in the WebFacing perspective.

Selecting members to convert 

To select members to convert: 

1.   Select the WebFacing project you have been working on in the previous 

module, wflabxx. 

2.   Expand this project by clicking the plus sign (+) beside its icon in the 

WebFacing Projects view.
  

 

You should see a DDS folder in the expanded view. 

If you don’t see a DDS folder, you might be in the Navigator view and not in 

the WebFacing Projects view. 

3.   Check that the view title bar is not WebFacing projects. 

4.   Locate the WebFacing Projects tab at the bottom of the list view, and click it. 
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Now the WebFacing Projects view should be active and you should be able to 

find the DDS folder.
  

  

5.   Expand the DDS folder, so that you can see all three of the members that you 

selected in the previous module. 

Next you convert these members.

You have selected members to convert and now you are ready to begin “Exercise 

3.2: Starting the WebFacing conversion.” 

Exercise 3.2: Starting the WebFacing  conversion 

Before you begin, you must complete “Exercise 3.1: Selecting the project and source 

members” on page 27. 

From here you can select individual members to convert or a collection of 

members. When you later in this tutorial change only one source member you will 

select a single member to be converted. Since you want to convert all members in 

the project, you can actually work with the WebFacing project icon to convert DDS 

and UIM panel group members. 

1.   Right-click the wflabxx WebFacing project. 

 

Chapter 3. Module  3. Converting  selected source  members  29



2.   Click Convert on the pop-up menu. 

The conversion process starts. You will see a progress dialog, indicating what 

members are being converted.
  

 

Wait until the progress dialog disappears, indicating the WebFacing conversion 

has finished. 

You have converted members and now you are ready to begin “Exercise 3.3: 

Checking the conversion logs” on page 31. 
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Exercise 3.3: Checking the conversion logs 

Before you begin, you must complete “Exercise 3.2: Starting the WebFacing 

conversion” on page 29. 

Notice the conversion log in the right pane of the workbench.
  

 

To check the conversion log: 

1.   Click the Overview tab. 

2.   Click the Reference Keywords tab. 

3.   Click the DSPF Conversion Log tab. 

4.   Click the UIM Help Conversion Log tab.

As  you click each tab you will see more details about each log. 

You have now converted the DDS display file and panel group source. 

The DDS source and panel group source is now available in a form a browser 

understands. The first important step to move your application to the Web is done. 

Notice, the conversion itself was pretty easy, because you already did the hard part 

when you created the WebFacing project. Now that the project exists the 

WebFacing Tool has all the information readily available and even having to 

re-convert later because of changes in the original source is not a big problem. 

You have checked the DSPF and UIM conversion logs for errors. 

Module recap 

You have completed Chapter 3, “Module 3. Converting selected source members,” 

on page 27. You have learned how to: 

v   Select members to convert 

v   Convert members 

v   Check reference keywords for errors 

v   Check the DSPF conversion log for errors 
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v   Check the UIM conversion log for errors

You  have used the WebFacing Tool to convert the user interface of the Order Entry 

application and you now want to see the conversion results. The WebFacing Tool 

created a complete Web application that can be run in an Application Server. The 

WebSphere Application Server test environment and the Web project in the 

workbench are completely integrated and without publishing (copying) any of the 

files in the Web project they are known to the WebSphere Application Server test 

environment. 

The index.jsp file that has been created by the WebFacing conversion routine is 

part of this Web project. It will be used as the default page for this Web 

application. When the application is up and running you will go through the same 

scenarios as in Chapter 1, “Module 1. Reviewing the 5250 order entry application,” 

on page 1 when you went through the green screen panels of the Order Entry 

application but now you are using the new WebFacing user interface. 

Next you will run your application with its new user interface. Continue to 

Chapter 4, “Module 4. Running the WebFacing application,” on page 33. 
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Chapter  4.  Module  4.  Running  the  WebFacing  application  

You normally would now have to copy all the files of your Web project to a 

WebSphere Application Server and then run your application there. However, there 

is a WebSphere Application Server included with the product and it is called the 

WebSphere Test Environment (WTE). Using WTE  makes the process of locally 

testing your WebFacing application easier than testing on a remote WebSphere 

Application Server. 

In your real application development environment, you would test thoroughly in 

the test environment; then export the WebFacing project files to a remote 

WebSphere Application Server for final testing, before moving the Web-enabled 

application to your production WebSphere Application Server environment. 

Chapter 12, “Module 12. (Optional) Exporting to iSeries WebSphere Application 

Server Express 5.1,” on page 111  shows you the steps required to deploy to a 

remote WebSphere Application Server environment. Until you are sure your 

WebFacing application is ready for public use, you can use the test environment on 

your workstation, which simplifies the testing of Web applications. 

This module teaches you how to test your WebFacing application in the 

WebSphere Test environment. You will learn how to specify in the WebFacing 

perspective that you want to run your project in the WebSphere Test Environment. 

From the initial Web page, you will learn how to select the link created by the 

WebFacing Tool to invoke the WebFacing Order Entry application. 

In this module, you will: 

v   Set the WebSphere Test Environment to test the application locally 

v   Launch the WebFacing application 

v   Prompt for a customer 

v   Select a customer from a list of customers 

v   Prompt for a part 

v   Select a part from a list of parts 

v   Enter a quantity for a part 

v   Display help for the customer selection list

Exercises 

The exercises within this module must be completed in order: 

v   “Exercise 4.1: Showing the index.jsp page” on page 34 

v   “Exercise 4.2: Testing the WebFacing application” on page 36 

v   “Exercise 4.3: Testing the help support” on page 39

Time  required 

This module will take approximately 15 minutes to complete. 
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Exercise 4.1: Showing the index.jsp page 

To show the index.jsp page: 

1.   Right-click the wflabxx WebFacing Projects folder.
  

  

2.   Click Run on server on the pop-up menu. 

A Server Selection dialog opens.
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You can avoid having this dialog open every time you select run on server. 

3.   Leave the Test Environment selected. 

4.   Select the Set server as project default (do not prompt) check box. 

5.   Click Finish. 

The WebSphere Application Server test environment starts. After a few 

moments the browser opens in the upper right view area of the workbench. Be 

patient; it takes time for the application server to start on your workstation. 

The minimum memory requirement for running the WebSphere Application 

Server test environment is 768 MB according to the IBM announcement letter 

for the product Version 5. You can run this WebFacing project successfully on 

systems with 256 MB. It will take more time for the application server to start if 

you are working on a workstation that has less than the required memory. The 

system speed will also have an impact on the application server start up time. 

Eventually you will see the index.jsp page that has been generated by the IBM 

WebFacing Tool opening in the workbench’s built-in browser. 

Here you see the browser inside the workbench with the index.jsp page 

displayed.
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Tip: To enlarge the browser window to the size of the workbench window, 

double-click the browser title bar. To get it back to its original size in the upper 

right hand workbench view area, double-click the enlarged browser window 

title bar. 

You have a choice of running WebSphere Application Server Version 4 or 

Version 5 in the workbench test environment. In this tutorial you will be using 

WebSphere Application Server Version 5 in the Test Environment and J2EE level 

1.3.

Note:  Be aware if you use WebSphere Application Server Version 4 which only 

supports J2EE level 1.2, you need to setup your application server 

environment to enable UTF-8 support. This setup has to be performed 

for every application server that runs a WebFacing application. 

Instructions on how to setup the WebSphere Application Server 

environment for UTF-8 are contained in the WebFacing online help. In 

this tutorial you can ignore this step because you are using J2EE 1.3 

which sends this information dynamically to the application server.

You  have set the WebSphere Test Environment to test the application locally and 

now you are ready to begin “Exercise 4.2: Testing the WebFacing application.” 

Exercise 4.2: Testing  the WebFacing  application 

Before you begin, you must complete “Exercise 4.1: Showing the index.jsp page” 

on page 34. 

To run the Web application: 

 1.   In your browser pane, click the Launch link.

Note:  For the product Version 4 users, you have to click twice on the link. 

The first click will give the browser focus; the second click will actually 

send the click event. 

After a few moments the first application page opens in the browser.
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If you find the response time slow, keep in mind that the first time the JSP file 

is requested, it has to be compiled into a servlet the first time. If you run the 

application a second time, you will see improved performance since the 

servlet already exists. This is normal application server behavior. 

Now you want you to go through the same steps as in Chapter 1, “Module 1. 

Reviewing the 5250 order entry application,” on page 1 to review the results 

of the WebFacing conversion. This will give you a sense of how the default 

conversion will change your original application. You will then have a chance 

to improve the conversion results. 

 2.   Click the Prompt button, or press command key F4 to open the selection list 

window. 

  

  

 3.   Select a customer from the list (this is your converted subfile). 
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4.   Press the Enter key. 

 5.   Click the Prompt button, or press command key F4 to display the parts 

selection list.
  

  

 6.   Select a part. 

 7.   Press the Enter key. 

The Parts Order Entry window opens.
  

  

 8.   Enter a quantity. 
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9.   Press the Enter key. 

10.   Continue ordering one or two more parts. 

11.   Press command key F6 to accept the order. 

The application works the same way as before in a 5250 environment; but the 

application now has a browser user interface.

You have launched the WebFacing application, prompted for a customer, selected a 

customer from the list of customers, prompted for a part, selected a part from a list 

of parts and entered a quantity for a part and now you are ready to begin 

“Exercise 4.3: Testing the help support.” 

Exercise 4.3: Testing  the help support 

Before you begin, you must complete “Exercise 4.2: Testing the WebFacing 

application” on page 36. 

To test the help: 

1.   Press the F1 key. 

Another browser window opens with the help information.
  

  

2.   Now try the links: 

v   1. Select 

v   2. Enter number 

v   Extended help 

Your UIM based help panels are all available in the WebFacing application. 

3.   Close the help browser window and press F3 to end the application. 

You have displayed the help for the customer selection list. 

Module recap 

You have completed Chapter 4, “Module 4. Running the WebFacing application,” 

on page 33. You have learned how to: 

v   Set the WebSphere Test Environment to test the application locally 

v   Launch the WebFacing application 

v   Prompt for a customer 

v   Select a customer from a list of customers 

v   Prompt for a part 

v   Select a part from a list of parts 
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v   Enter a quantity for a part 

v   Display help for the customer selection list

Next you want to improve the user interface generated by the WebFacing Tool. You 

want to improve the customer selection subfile. The Web user interface for 

selecting a record from this subfile does not work like a Web application. You have 

to key 1 into the options column to select a record; this is how the green screen 

application works. You want a Web user interface where you can click on a link to 

select a customer. 

You will be guided through the Web Setting capabilities in CODE Designer to 

make the necessary modifications. You will change the second column in the 

customer selection subfile, which contains the customer name, from a simple text 

output field to a link. When you click on this new customer name link, the correct 

information your program expects is sent. You might ask what is the correct 

information? What is your program expecting? It is expecting a 1 in the subfile 

options field for the selected customer record. The program will receive the same 

information after you change the user interface. 

The WebFacing conversion will add logic to the user interface, so that the options 

field is filled with a 1 and the Enter key event is invoked when the link is pressed. 

You enhance the user interface and don’t have to change the application, this 

sounds pretty impressive doesn’t it. Continue to Chapter 5, “Module 5. Changing 

the user interface,” on page 41. 
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Chapter  5.  Module  5.  Changing  the  user  interface  

To enhance the results of the WebFacing Tool, you will use the feature Web 

Settings in the CODE Designer tool. CODE Designer is the GUI-based screen 

design tool for 5250 panels. It allows you to change certain aspects of the user 

interface related to the WebFacing conversion process. CODE Designer stores the 

Web Setting information as comment lines in the DDS source. When you convert 

the application using the IBM WebFacing Tool, these DDS source comment lines 

are picked up and applied to the new user interface. 

This module teaches you how to change the user interface of your WebFacing 

application with CODE Designer. In the WebFacing perspective you will learn how 

to select a DDS source member to work with; start CODE Designer to open this 

DDS member; work with Web Settings in CODE Designer to change the Web look, 

and then reconvert the DDS member. 

In this module, you will: 

v   Locate a DDS source member 

v   Open a DDS source member with CODE Designer 

v   Create a hyperlink action for the option field 

v   Hide the option field 

v   Hide the option heading for the option field 

v   Hide the select instruction 

v   Change the appearance of text 

v   Close CODE Designer 

v   Reconvert the DDS source member 

v   Launch the reconverted WebFacing application 

v   Prompt for a customer 

v   Verify the changes in the customer selection window

In  order to accomplish these learning objects, there are several steps that are 

involved, including: 

v   “Exercise 5.1: Opening DDS display file source” 

v   “Exercise 5.2: Applying Web Settings” on page 42 

v   “Exercise 5.3: Testing the changed application” on page 49

The exercises within each module must be completed in order. Start with “Exercise 

5.1: Opening DDS display file source” when you are ready to begin. 

Length of time: 

This module will take approximately 15 minutes to complete.

Exercise 5.1: Opening DDS display file source 

Since you will use the WebFacing perspective to invoke CODE Designer you start 

this exercise using the product in the WebFacing perspective. 

Starting the product and opening the Web perspective (optional) 
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Skip this section if the product is already started and the Web perspective is 

already open. 

To start the product and opening the Web perspective: 

1.   Start the product and open the WebFacing perspective, if it is not up and 

running already. 

2.   In the WebFacing perspective, make sure that you are in the WebFacing Projects 

view and not the Navigator view. 

3.   Expand your project in the WebFacing Projects view by clicking on the plus 

sign (+) beside the WebFacing project icon if not already.

Opening CODE Designer 

1.   Locate the DDS display file source named STLCUSTD. 

2.   Right-click SLTCUSTD and click Open with > CODE Designer on the pop-up 

menu. 

You have located the DDS source member and opened it with CODE Designer and 

now you are ready to begin “Exercise 5.2: Applying Web Settings.” 

Exercise 5.2: Applying Web  Settings 

Before you begin, you must complete “Exercise 5.1: Opening DDS display file 

source” on page 41. 

Now work with the Notebook underneath the Design page. 

Creating a hyperlink for the option field 

To create an hyperlink for the option field: 

 1.   Click theSCREEN1 tab. 

 2.   Locate the Web Settings tab.
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3.   Place the cursor on line 8, column 7. 

 4.   Click the Web Settings tab. 

The Web Settings page in the CODE Designer window opens.
  

  

 5.   On the Web Settings page, locate the list that shows the different Web Settings 

available for the Customer field. 

 6.   If not all Web Settings show, scroll down to the bottom of the list. 

 7.   Click Create hyperlink in the Web Settings list.
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8.   Select the Create hyperlink check box to the right of the list. 

 9.   Click the Action hyperlink radio button. 

10.   Leave the Position cursor to field check box selected. 

11.   From the list under the Position cursor to field select the &{OPT} value. 

12.   In the Enter data list type 1. 

This indicates that you want a 1 to be entered in the Opt field when the 

hyperlink is clicked. 

13.   Select the Submit check box. 

14.   Leave the Function key radio button selected. 

15.   Select ENTER from the Function key list. 

Just to recap, you specified the following, when the application gets converted 

with the WebFacing Tool; the customer name cells in the subfile will be 

generated so they appear as links in the browser window. At run time, when 

the link is clicked, a 1 will be placed in the Option field. Also, a submit 

request will be initiated to generate the equivalent of pressing the Enter key 

and the cursor will be positioned in the Option field for the selected row. 

You have accomplished the basic task, but the user interface now has an 

Option column that doesn’t belong there since it is useless with the new link. 

Also the instructions on the page on how to select a customer are wrong. You 

want you to fix this with Web Settings as well before you test this new 

feature.

Hiding the option field 

On the Design page, you now need to select the option field to indicate that you 

want to work with it: 
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To hide the option heading: 

1.   Click the Opt column on the first record in the subfile to select it. 

2.   On the Web Settings page select Visibility from the list. 

3.   Select the Hide field radio button. 

Now this column in the subfile will be hidden.

Hiding the option heading for the option field 

You need to hide the heading for the option field as well. The heading is not in the 

subfile record; it is located in the subfile control record. Therefore you need to give 

focus to a different record format in the Design page. What does this mean? It 

looks like one record format but there are three record formats in this view. 

Lets look at some of the CODE Designer features. Normally in the iSeries green 

screen world, your screens are made up out of multiple record formats that at 

runtime get assembled by the RPG or COBOL program to present the real screen 

your end user sees. 

To make it easier for you at design time to get a feel how the record formats you 

create would look like at runtime, CODE Designer has added the notion of a 

group. You can assemble several record formats in a group. This feature gives you 

the capability of mimicking what happens at runtime with your record formats. So 

a group resembles the runtime grouping of record formats for you at development 

time. In the sample you are working with, there are already assembled three record 

formats in group SCREEN1. The record formats are: 

v   CUSTSFL 

v   CUSTCTL 

v   SLTCUST

To get a list of record formats belonging to a group you can expand the list of 

record formats.
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Only one record format in a group is active at a time. The record format name is 

listed in the top field of the record list. Also in the Design page all parts in the 

active record format are shown highlighted but the inactive record format content 

is half-intensity. You see this effect very clearly above. Until now you have been 

working with the subfile record format CUSTSFL only, but now you need to clean 

up the subfile control record format CUSTCTL, so you need to make it the active 

record format or another way to describe this, give it focus. 

To hide the option heading Opt Customer: 

1.   To shift focus to another record format, at the top of the Design page, click the 

arrow. 

  

 

You will notice that the top area of the Design page is now highlighted, and the 

bottom one has only half-intensity. As mentioned before the highlighted area is 

the one you can work with. 

Next you clean up the subfile control record format.
  

  

2.   On the Design page, select the OPT Customer constant. 

3.   On the Web Settings page, select Appearance and Text from the list. 

4.   Select the Hide characters check box. 

5.   Leave 1 in the From field. 

6.   Type 3 in the To field. 

This hides the heading Opt. Now you need to remove the instructions on the 

panel that guide the user to put a 1 into the Opt field to select a specific 

customer.

Hiding the select instruction 
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You don’t have to give focus to a different record format since this constant is also 

located on the CUSTCTL subfile control record format. 

To hide the select instruction: 

1.   Select the constant 1=Select in the Design page.
  

  

2.   On the Web Settings page select Visibility from the list. 

3.   Click the Hide field radio button.

Changing the instruction (Type choice press Enter) 

Now you need to add new instructions for the WebFacing page, so the end user 

knows to click the link to select a customer. 

Note:  Note you can’t just change the 5250 constant because you might still use this 

screen in a 5250 environment, you have to use Web Settings to apply this 

change to the Web user interface only. 

To change the instruction text: 

1.   Select the instruction constant (Type choices press Enter) on the Design page.
  

  

2.   On the Web Settings page, select Appearance and Text from the list. 
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3.   Select the Override constant text check box, and type the new text Click on 

link to select in the field to the right of the check box. 

Now all Web Settings are in place and you can go ahead and save the DDS 

source and reconvert this DDS member.

Closing CODE Designer and reconverting the DDS source member 

To close CODE Designer and re-convert the DDS member: 

1.   Click the X button at the top right corner of CODE Designer.
  

  

2.   Click Yes to save, when asked to do so. 

You return to the WebFacing perspective in the workbench. 

3.   Select your project wflabxx in the WebFacing Projects view. 

4.   Expand the project by clicking on the plus sign (+) in front of its icon, if you 

can’t see the DDS folder as part of the project. 

5.   Expand the DDS folder, if it is not expanded already, to show all members in 

this folder.
  

  

6.   Select the member SLTCUSTD that you just changed. 

7.   Right-click SLTCUSTD member icon. 

8.   Click Convert on the pop-up menu. 

Only this member will be converted. A conversion report opens after the 

conversion is finished. Now you test the new user interface. 

You return to the WebFacing perspective in the workbench.

You  have created a hyperlink action for the option field, hidden the option field, 

the option heading and the select instruction, changed the appearance of text, 

closed CODE Designer and reconverted the DDS source member and now you are 

ready to begin “Exercise 5.3: Testing the changed application” on page 49. 
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Exercise 5.3: Testing  the changed application 

Before you begin, you must complete “Exercise 5.2: Applying Web Settings” on 

page 42. 

Let’s see the new user interface in your application. 

To test the changed application: 

1.   Right-click the wflabxx project icon in the WebFacing Projects view. 

2.   Click Run on Server on the pop-up menu. 

3.   Go to the browser pane and click the Launch link. 

You will see the first screen of your application. Nothing has changed there. 

4.   Click the Prompt push button, or press command key F4. 

  

 

The customer selection window appears and the customer fields are shown as 

links. Also notice the changed text and the non-visible option column.

Note:  If the customer selection window is still showing the old option 

selections, most likely the browser has cached the page and you need to 

close the browser window, and restart the application. This will open a 

new instance of the browser without cached content. 

5.   Select a customer from the list by clicking on the link. 

6.   Go through the same steps as in Chapter 1, “Module 1. Reviewing the 5250 

order entry application,” on page 1 to test the changed application.

You  have launched a reconverted WebFacing application, prompted for a customer 

and verified the changes in the customer selection window. 

Module recap 

You have completed Chapter 5, “Module 5. Changing the user interface,” on page 

41. You have learned how to: 

v   Locate a DDS source member 

v   Open a DDS source member with CODE Designer 

v   Create a hyperlink action for the option field 
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v   Hide the option field 

v   Hide the option heading for the option field 

v   Hide the select instruction 

v   Change the appearance of text 

v   Close CODE Designer 

v   Reconvert the DDS source member 

v   Launch the reconverted WebFacing application 

v   Prompt for a customer 

v   Verify the changes in the customer selection window

When you tested the changed application, you found that you didn’t like the way 

the WebFacing Tool mapped some of the display attributes to colors and text styles 

available in the browser. You wanted to change the default WebFacing style rules 

that determine how certain 5250 parts are displayed in a browser to give the Web 

user interface a better look. Now you will make these changes. Continue to 

Chapter 6, “Module 6. Changing the style of the Web user interface,” on page 51. 
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Chapter  6.  Module  6.  Changing  the  style  of the  Web user  

interface  

This module teaches you how to change the user interface of your WebFacing 

application by using the WebFacing style properties dialog. The style changes are 

applied on a project level; so all pages in a project will be displayed with these 

changes applied. In this module you will change the text color and font for all 

highlighted fields. You will also locate the style file where these changes have been 

stored. 

In this module, you will: 

v   Start the Style Properties dialog 

v   Change the DDS Field Display Attributes 

v   Locate the cascading style sheet file 

v   Edit the cascading style sheet file 

v   Check the new styles

Exercises 

The exercises within each module must be completed in order: 

v   “Exercise 6.1: Changing the rules for highlighted fields” 

v   “Exercise 6.2: Changing styles directly” on page 54 

v   “Exercise 6.3: Testing the changed application” on page 58

Time required 

This module will take approximately 5 minutes to complete. 

Exercise 6.1: Changing the rules for highlighted fields 

During this exercise you will use the Style Properties dialog in the IBM WebFacing 

Tool to tailor your Web user interface. You will change the rules for highlighted 

fields in the 5250 panels so they appear more visible in the Web user interface. The 

style for highlighted fields will be altered so at runtime the text font will be 

different and a larger font size will be applied. 

To change the rules for highlighted fields: 

 1.   Start the workbench of the product and open the WebFacing perspective, if it 

is not up and running already. 
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2.   Right-click the wflabxx project. 

 3.   Click Properties on the pop-up menu. 

The WebFacing project properties dialog opens.
  

  

 4.   Under Style in the left pane of the Properties for wflabxx, click DDS Field 

Display Attributes. 

In the right pane of the Properties for wbflabxx, the DDS Field Display 

Attributes pane opens.
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5.   Click the .. push button to the right of the High intensity field. 

The Font dialog opens.
  

  

 6.   Under the Font list, select Comic Sans MS. 

 7.   Under the Font style list, select Bold. 

 8.   Under Size, select 16.  

Note:  Don’t try to change the color in this dialog, the color setting doesn’t 

work, later in this module you will see how to change the color. 

This changes the font size and appearance for parts that have the high 

intensity attribute active. 

 9.   Click OK on the Font dialog. 

10.   On the Properties page, click OK.
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Checking the new style 

Let’s check the new style in your application. 

To check the new style: 

1.   Right-click the project icon in the WebFacing Projects view. 

2.   Click Run on Server on the pop-up menu. 

3.   Go to the browser pane and click the Order Entry link. 

You will see the first screen of your application.

Note:  See the different font and font size of some of the text; these are the 

highlighted areas of your 5250 screen. 

4.   Prompt for the customer. 

The customer selection screen has highlighted text and this text should show in 

font Comic Sans MS and size 16.
  

 

Note:  If the text is still showing the old fonts, most likely the browser has 

cached the page and you need to close the browser window, and restart 

the application. This will bring up a new instance of the browser without 

cached content. 

5.   The Font dialog has a bug that makes it impossible to change the Font colors 

directly. Next you see how to directly change WebFacing style classes.

You  have started the Style Properties dialog, changed the DDS Field Display 

Attributes and checked the new style and now you are ready to begin “Exercise 

6.2: Changing styles directly.” 

Exercise 6.2: Changing styles directly 

Before you begin, you must complete “Exercise 6.1: Changing the rules for 

highlighted fields” on page 51. 

Instead of working with properties in the WebFacing project you can also change 

the styles being applied directly in the Cascading Style Sheet (.css) file that 
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WebFacing uses. In this exercise you see where this file is located in the WebFacing 

Project structure and how to find your way around in this file. 

To locate the Cascading Style Sheet file: 

1.   Click the Navigator tab to switch to the Navigator view. 

  

  

2.   Locate the apparea.css file in the WebFacing project.
  

 

It is located in the following directory hierarchy: 

wflabxx\WebContent\webfacing\styles\apparea\ 

3.   Double-click the apparea.css file icon in the Navigator view, to open an editor 

for this file. 

Next you change the WebFacing highlighted style class. 

The editor dialog will open and show the style source. 

4.   Scroll down the source file until you reach the .wf-hi class.
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You’ll notice your changes from the previous exercise are applied here. The 

WebFacing Tool has created style sheet classes for the different 5250 parts and 

attribute combinations and stored them here. Each of the lines starting with a 

dot is containing a style class name. The statements inside the curly brackets 

after the style class name describe the attributes of the class itself. For this 

WebFacing .css file, the name of the classes are self describing, for example 

.wf_hi defines how a part that has the highlighted attribute active gets 

displayed in the browser, wf_cs describes the column separator, etc. You can go 

in and change the display characteristics for any of the 5250 attributes. 

Next you change the color attribute of the highlighted class. 

5.   Position the cursor at the end of the last line of the wf_hi class, before the 

ending curly (}) bracket. 

6.   Press the Enter key to insert a line. 

7.   Enter the color attribute you want to use, for example: color: red;
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Note:  Don’t forget the semicolon to delimit the line. 

8.   Save the change by clicking the Save icon in the workbench. 

  

 

For version 5 users, there is a feature available in the Style sheet editor that 

allows you to look at the changes you have made to a class directly in the 

editor without actually invoking the page and showing in a browser. 

9.   Look at the left beside the Style sheet editor.
  

 

To see the changed user interface, run the application again.

You have located the cascading style sheet file and edited it and now you are 

ready to begin “Exercise 6.3: Testing the changed application” on page 58. 
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Exercise 6.3: Testing  the changed application 

Before you begin, you must complete “Exercise 6.2: Changing styles directly” on 

page 54. 

To test the changed WebFacing application: 

1.   Click the X in the Window bar of any editors or views still open at the right 

upper hand side of the workbench to close them all. 

Now let’s check the new style attribute in your application. 

2.   Right-click the project icon in the WebFacing Projects view or Navigator view 

in the WebFacing perspective. 

3.   Click Run on Server on the pop-up menu. 

4.   Go to the browser pane and click the Order Entry link. 

You will see the first screen of your application. Notice the different color of the 

text in the highlighted areas of your Web page. Prompt for the customer. The 

customer selection screen will show the same changed attributes; remember 

style changes are applied to all pages as shown. 

  

 

Note:  If the text is still showing the old colors, most likely the browser has 

cached the page and you need to close the browser window, and restart 

the application. This will open a new instance of the browser without 

cached content. 

You might not have noticed it before, but there is still a command key 

description at the bottom of the Customer Selection list window. 

You might have guessed it; you will fix this in the next module. 

Module recap 
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You have completed Chapter 6, “Module 6. Changing the style of the Web user 

interface,” on page 51. You have learned how to: 

v   Start the Style Properties dialog 

v   Change the DDS Field Display Attributes 

v   Locate the cascading style sheet file 

v   Edit the cascading style sheet file 

v   Check the new styles

In the sample Order Entry application, the Customer Selection list window doesn’t 

follow the CUA® rules for command key descriptions. The WebFacing Tool will by 

default not recognize these command key descriptions and will not delete them. 

The Order Entry main screen has a command key enabled that has no description 

associated with it. The WebFacing Tool by default can’t handle this situation and 

puts a default string in the push button label representing this command key. Next 

you learn how to enable the WebFacing Tool to deal with these common green 

screen environments. Continue to Chapter 7, “Module 7. Adding command key 

rules and labels,” on page 61. 
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Chapter  7.  Module  7.  Adding  command  key  rules  and  labels  

Most of the command key descriptions placed at the bottom of the original panels 

in the sample Order Entry Application have been removed from the WebFacing 

user interface. The removal happens automatically if the command key 

descriptions follow the Common User interface Access (CUA) rules (for example, 

F3=Exit). If they don’t follow these rules you can supply the WebFacing Tool with 

the command key description rules you use in your user interface, and the 

WebFacing Tool will apply these rules to recognize your specific command key 

descriptions. One of the record formats in the sample application contains a 

command key description that doesn’t follow the CUA rules. 

This module teaches you how to use the WebFacing conversion properties dialogs 

to add your own command key description rule. Also in your user interface you 

might have enabled command keys without describing them in the user interface 

because they are only used for specific functions and your end user knows how 

they work. For example command key 3 for ending an application or command 

key 12 for canceling a task are well known to be enabled for these tasks. So your 

user interface might not list them explicitly at the bottom of the panel. The 

problem with this kind of user interface design, the WebFacing Tool doesn’t have a 

string it can put in the label of the push buttons on the Web page. It will just put 

for example CF12 for an active command key 12 in the push button label. 

However there is an alterative, the WebFacing Tool allows you to specify labels for 

these common command keys so it can label the command key push buttons 

correctly. You just have to tell the WebFacing Tool in its conversion properties what 

the label is. 

In this module, you will: 

v   Start the Properties dialog 

v   Select Command Key Recognition Patterns 

v   Add a new command key rule 

v   Reconvert the DDS members 

v   Test the applied new rule 

v   Change the text for the F12 command key 

v   Reconvert the DDS members 

v   Test the new command key label

Exercises 

The exercises within this module must be completed in order: 

v   “Exercise 7.1: Adding a new command key description pattern” on page 62 

v   “Exercise 7.2: Adding command key button labels” on page 65

Time  required 

This module will take approximately 10 minutes to complete. 
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Exercise 7.1: Adding a new command key description pattern 

The prefix for the command key description in the SLTCUST record format is 

Fkey=. 

  

 

This doesn’t follow the CUA rules normally used in iSeries user interfaces, so the 

WebFacing conversion does not recognize this pattern and does not hide it. You 

have to add this prefix pattern to the WebFacing Tool conversion rules in the 

WebFacing Properties dialog. 

To add a new command key description pattern to WebFacing conversion rules: 

1.   In the WebFacing Projects view, right-click your WebFacing project wflabxx. 

2.   Click Properties on the pop-up menu.
  

 

The Properties for wflabxx dialog opens.
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3.   In the left pane of the Properties for wflabxx, under Conversion, select 

Command Key Recognition Patterns. 

The right pane will switch to Command Key Recognition Patterns.
  

  

4.   In the Prefix list, type Fkey 

5.   In the Separator list, leave = 

6.   Click Add to the right of these two lists. 

The additional rule is now part of this style. 

7.   Click OK.

Next, you will test this feature by converting the DDS member and running the 

application. 

Reconverting DDS members 

Since these are conversion properties you are changing and not style properties as 

in the previous module, you will need to reconvert all members that contain 

command key descriptions with this pattern. In the sample Order Entry application 

this is only member SLTCUSTD. 

To reconvert DDS members: 

1.   In the workbench in the WebFacing Project view, expand the wflabxx project, if 

not already expanded. 

2.   Expand the DDS folder, if not already expanded. 

3.   Right-click the SLTCUSTD member icon. 

4.   Click Convert on the pop-up menu. 

After the conversion, take a look at the change.

Testing the applied new rule 
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Let’s see how the new rule is applied to your WebFacing application. 

To test the applied new rule: 

1.   Right-click the project wflabxx in the WebFacing Projects view. 

2.   Click Run on Server on the pop-up menu. 

3.   Go to the browser pane and click the Order Entry link. 

You will see the first screen of the sample application. 

4.   Click Prompt or press F4. 

The Customer Selection list window opens.
  

 

Note:  Notice that the command key text Fkey12=Cancel is gone from the 

bottom of the window. 

5.   If the push button still shows, restart the Application server. 

a.   Click the Servers tab at the bottom view in the workbench. 

b.   Right-click the server icon. 

c.   Click Restart on the pop-up menu.
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d.   Run the application again.
6.   Select a customer or cancel by pressing F12 to return to the Order Entry 

Application window.

Now that you know how to change the command key recognition patterns in the 

WebFacing Tool, you can add text to frequently used command keys that don’t 

have a text description in the DDS source. 

  

 

Back on the Order Entry panel, you can see that the push button for F12 does not 

have a description. Its label shows F12. You will learn how to fix the label in the 

next exercise. 

You have started the Properties dialog, selected Command Key Recognition 

Patterns, added a new command key rule and reconverted the DDS members, 

tested the applied rule, and now you are ready to begin “Exercise 7.2: Adding 

command key button labels.” 

Exercise 7.2: Adding command key button labels 

Before you begin, you must complete “Exercise 7.1: Adding a new command key 

description pattern” on page 62. 

The WebFacing Tool allows you to specify command key descriptions for 

command keys that are commonly used in your application but not described in 

your DDS source and on your screens. This way the push button labels on the Web 

pages can automatically be changed during conversion to the correct text. You will 
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add the description Cancel to the WebFacing conversion properties so the push 

button will get created to show a Cancel label instead of F12. 

To add command key button labels: 

1.   Right-click your WebFacing project wflabxx.
  

  

2.   Click Properties on the pop-up menu. 

The Properties for wflabxx dialog opens. 

3.   In the left pane of this dialog, under Conversion select Command Key Button 

Labels. 

In the right pane of this dialog, the Command Key Button Labels opens. 
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4.   Under the Command key list, select F12. 

5.   Under the Button label list, select Cancel. 

6.   Click Add to the right of these two lists. 

The additional label is now part of the WebFacing conversion properties for 

this WebFacing project. 

7.   Click OK at the bottom of the Properties dialog. 

Next, back in the workbench, convert the changed application.

Reconverting DDS members 

To convert the application in the workbench: 

1.   Expand the wflabxx project if not already. 

2.   Expand the DDS folder if not already. 

3.   Right-click the ORDENTD member icon. 

4.   Click Convert on the pop-up menu. 

After the conversion, take a look at the change.

Testing the new label 

Let’s see the new label for the F12 push button in your WebFacing application. 

To test the new label: 

1.   Right-click wflabxx project in the WebFacing Projects view. 

2.   Click Run on Server on the pop-up menu.
  

  

3.   Go to the browser pane and click the Order Entry link. 

4.   Check that the Cancel push button on the first page now shows the correct 

label as shown. 

5.   If the push button still has the old text, restart the Application server. 

a.   Click the Servers tab at the bottom view in the workbench. 

b.   Right-click the server icon. 

c.   Click Restart on the pop-up menu.
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d.   Run the application again.

You have changed the text for the F12 command key, reconverted the DDS 

members and tested the command key label. 

Module recap 

You have completed Chapter 7, “Module 7. Adding command key rules and 

labels,” on page 61. You have learned how to: 

v   Start the Properties dialog 

v   Select Command Key Recognition Patterns 

v   Add a new command key rule 

v   Reconvert the DDS members 

v   Test the applied new rule 

v   Change the text for the F12 command key 

v   Reconvert the DDS members 

v   Test the new command key label

Now that you have a Web user interface so the green screen look doesn’t show 

through as much as after the first WebFacing conversion you did in Chapter 3, 

“Module 3. Converting selected source members,” on page 27; you want to add 

some more refinements to the appearance of your Web pages. Continue to 

Chapter 8, “Module 8. Working with more style properties,” on page 69. 
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Chapter  8.  Module  8.  Working  with  more  style  properties  

This module teaches you how to change the user interface further, using style 

properties. You will learn to work with WebFacing Tool style properties and check 

the changes by refreshing the style and running the application. 

In this module, you will: 

v   Start the Properties dialog 

v   Change the window style 

v   Change the subfile style 

v   Change the command key style 

v   Test the changed properties

Since a style is used on a project level, all Web pages in your project will contain 

the changes you apply to a particular style. 

Exercises 

The exercises within this module must be completed in order. 

v   “Exercise 8.1: Starting the WebFacing properties style dialog” 

v   “Exercise 8.2: Changing the appearance of the subfile” on page 71 

v   “Exercise 8.3: Customizing the appearance of command keys” on page 73 

v   “Exercise 8.4: Checking the new style” on page 74

Time  required 

This module will take approximately 10 minutes to complete. 

Exercise 8.1: Starting the WebFacing  properties style dialog 

First, you will use the WebFacing Style properties dialog to tailor your Web user 

interface. You will apply changes to the window layout of your screens, the subfile 

appearance will be changed, and you will enhance the command key push button 

looks. 

To start the WebFacing Properties dialog: 

 1.   Start the product and open the WebFacing perspective, if it is not up and 

running already. 

 2.   In the WebFacing Projects view, select the wflabxx project. 

 3.   Right-click the wflabxx project, and click Properties on the pop-up menu. 

The Properties dialog opens. 
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4.   Under Style in the left pane of the Properties dialog, select Window. 

The right pane of the Properties dialog shows the Window properties.
  

  

 5.   Select Title from the Windows areas list. 

 6.   Under Foreground click the 

   

push button to the right of the Color field. 

 7.   On the Color Chooser dialog, click Red. 
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8.   Then click OK in the Color Chooser dialog. 

The Window Properties page reappears. 

 9.   Click the 

   

push button to the right of the Font field. 

10.   Select font Comic Sans MS, size 16. 

11.   Click OK on the Font dialog. 

12.   Under Background, click the 

   

push button to the right of the Color list. 

13.   On the Color Chooser dialog, click Green. 

14.   Click OK on the Color Chooser dialog. 

The Windows properties dialog reappears. 

15.   Select Body in the Windows areas list at the top of the page.
  

  

16.   In the Border color list at the bottom of the page click the 

   

push button to 

the right of the Border color field. 

The Color Chooser dialog opens. 

17.   Select Blue. 

18.   Click OK in the Color Chooser dialog.

You have started the Properties dialog, changed the window style and now you 

are ready to begin “Exercise 8.2: Changing the appearance of the subfile.” 

Exercise 8.2: Changing the appearance of the subfile 

Before you begin, you must complete “Exercise 8.1: Starting the WebFacing 

properties style dialog” on page 69. 

To change the appearance of the subfile: 

1.   Back in the Properties dialog, under Style, select Subfile. 

The Subfile properties page opens on the right pane of the dialog.
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2.   Select Subfile record - odd row in the Subfile areas list. 

3.   Under Background, click the 

   

push button to the right of the Color field. 

The Color Chooser dialog opens. 

4.   Select light yellow.
  

 

Tip: If you are interested in the hex value of certain colors as they are used in 

the style classes, the Color Chooser dialog displays the hex values; see the 

value ″FF FF CC ″ 

5.   Click OK in the Color Chooser dialog. 

You return to the Properties dialog. 

6.   Select Subfile record - even row in the Subfile areas list at the top of the page.
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7.   Under Background, click the 

   

push button to the right of the Color field. 

The Color Chooser dialog opens. 

8.   Select a light green. 

9.   Click OK on the Color Chooser dialog. 

Now at runtime the odd and even records will be displayed with different 

background colors. Next you will customize the appearance of the command 

key push buttons. 

You have changed the subfile style and now you are ready to begin “Exercise 8.3: 

Customizing the appearance of command keys.” 

Exercise 8.3: Customizing the appearance of command keys 

Before you begin, you must complete “Exercise 8.2: Changing the appearance of 

the subfile” on page 71. 

To customize the appearance of command keys: 

1.   In the left pane of the Properties dialog under Style, select Command keys. 

The Command Keys properties opens on the right pane of the dialog. 
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2.   Change the Foreground color for all three states of the buttons: 

v   Default 

v   Rollover 

v   Button down 

Now you have finished customization. 

3.   Click OK on the Properties dialog.

You have changed the command key style and now you are ready to begin 

“Exercise 8.4: Checking the new style.” 

Exercise 8.4: Checking the new style 

Before you begin, you must complete “Exercise 8.3: Customizing the appearance of 

command keys” on page 73. 

Let’s see the new look of your application. 

To check the new style: 

1.   Right-click wflabxx project. 

2.   Click Run on Server on the pop-up menu. 

3.   Run the application. 

4.   Click Prompt. 

The application window shows different colors, and the subfile records are 

colored. The command key push buttons change color, depending on their 

state.
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Note:  If the text is still showing the old colors, most likely the browser has 

cached the page and you need to close the browser window, and restart 

the application. This will open a new instance of the browser without 

cached content.

You have tested the changed properties. 

Module recap 

You have completed Chapter 8, “Module 8. Working with more style properties,” 

on page 69. You have learned how to: 

v   Start the Properties dialog 

v   Change the window style 

v   Change the subfile style 

v   Change the command key style 

v   Test the changed properties

You have tested your WebFacing application with updated style properties and 

now you want to customize the style further by updating the look and feel for a 

fictional company. Continue to Chapter 9, “Module 9. Customizing the default 

style,” on page 77. 
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Chapter  9.  Module  9.  Customizing  the  default  style  

Development Studio Client is built upon WebSphere Studio Site Developer. Site 

Developer contains editors for HTML and Cascading Style Sheet (CSS) files. When 

you created the WebFacing Web project, you selected a default style to your 

Web-enabled application. This module teaches you how to customize that style, 

updating the look and feel for a fictional company. You will change the color of the 

application and add a company logo as shown below.
  

 

In this module, you will: 

v   Locate the existing style 

v   View the design of the existing style 

v   Import the company logo 

v   Edit the style sheet to include the company logo 

v   Edit PageBuilder.jsp to remove and resize fields for your logo 

v   Change the color

Exercises 

The exercises within this module must be completed in order: 
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v   “Exercise 9.1: Opening Pagebuilder.jsp” 

v   “Exercise 9.2: Importing the company logo” on page 79 

v   “Exercise 9.3: Editing the style sheet and PageBuilder.jsp” on page 79

Time  required 

This module will take approximately 15 minutes to complete. 

Exercise 9.1: Opening Pagebuilder.jsp 

First you open the JSP file called PageBuilder as you want to edit this file to add a 

new company logo in a follow-on exercise. PageBuilder.jsp is the main JSP for the 

WebFacing project. 

To open the PageBuilder.jsp: 

1.   Open the product in the WebFacing perspective, if it is not already open. 

2.   Expand wflabxx > Style > gradient > chrome > html in the WebFacing Projects 

view. 

3.   Open PageBuilder.jsp by double-clicking the file. 

4.   Click the Design tab to see the existing style, shown below.
  

 

You will now change the style to reflect a fictitious XYZ Company.

You  have seen the design of the existing style and now you are ready to begin 

“Exercise 9.2: Importing the company logo” on page 79. 
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Exercise 9.2: Importing the company logo 

Before you begin, you must complete “Exercise 9.1: Opening Pagebuilder.jsp” on 

page 78. 

To import the company logo: 

1.   The first step is to import the company logo. Select chrome in the WebFacing 

Projects view, then click File > Import from the workbench menu. 

2.   Select File System in the Import wizard, and click Next. 

3.   On the next page of the wizard, click Browse and go to the C:\WFDEMO 

folder and click OK. 

4.   Select the check box next to sample_header.gif in the right list. 

5.   Make sure that the destination folder is set to 

wflabxx/WebContent/webfacing/styles/chrome, where xx is replaced by your 

unique team number. 

6.   Click Finish.

You have imported the company logo and now you are ready to begin “Exercise 

9.3: Editing the style sheet and PageBuilder.jsp.” 

Exercise 9.3: Editing the style sheet and PageBuilder.jsp 

Before you begin, you must complete “Exercise 9.2: Importing the company logo.” 

You must now edit the style sheet to configure the header to include the company 

logo that you just imported. Then you edit PageBuilder.jsp to resize the table to 

add the new company logo. Finally you make further changes to the style sheet to 

remove existing images (side_curve.gif and side.gif) and to change the color of 

these areas of your application. 

To edit the style sheet and then PageBuilder.jsp 

 1.   Expand wflabxx > Style > gradient > chrome in the WebFacing Projects view, 

right-click gradient.css and click Open from the pop-up menu. 

 2.   In the Styles view, double-click .headc to edit that style.
  

  

 3.   Select *Background. 

 4.   Update the Image field to sample_header.gif and change the Repeat field to 

No repeat as shown. 
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5.   Click OK. 

 6.   Save gradient.css by pressing CTRL-S. 

 7.   Now you must edit PageBuilder.jsp. 

 8.   Click the PageBuilder.jsp tab. Then go to the Source tab. 

 9.   Change the table height to 100 and width to 1024. 

10.   Delete the first <td>...</td>. 

11.   Change: 

<td class=headc colspan=4 rowspan=1 width="441" height="33"> 

to: 

<td class=headc colspan=6 rowspan=1 width="100%" height="100"> 

12.   Delete the next <td>...</td>. 

This removes the extra fields in the table and resizes the remaining ones for 

your logo. 

Your code should now look like this: 

<table id=&cdqg;<%=(String)session.getAttribute(&odq;UniqueId&cdqg;) 

%>_Table&cdqg; border="0" cellspacing="0" cellpadding="0" 

 frame="box" height="100" width="1024"> 

  <tbody> 

  <tr> 

    <td class=headc colspan=6 rowspan=1 width="100%" height="100"> 

      <%=request.getAttribute("ApplicationTitle")%> 

    </td> 

13.   Save PageBuilder.jsp. 

14.   Click the Design tab. 

It should look as shown below: 
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15.   Now update the color of the side by selecting the gradient.css tab again. 

16.   In the Styles view, double-click .thesidecurve. 

17.   Select *Background. 

18.   Remove side_curve.gif from the Image field, leaving it blank. 

19.   From the drop-down list next to the Color field, select the color gray. 

20.   Click OK again to update the Style property. 

21.   Open .theside style from the Styles view. 

22.   Remove side.gif from the Image field, leaving it blank. 

23.   From the drop-down list next to the Color field, select the color blue. 

24.   Click OK again to update the property. 

25.   Save gradient.css by pressing CTRL-S . 

26.   Run the wflabxx application on the test server to see the new style, shown 

below: 
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You have edited the style sheet to include the company logo and edited 

PageBuilder.jsp to remove and resize fields for your logo. 

 Module recap 

You have completed Chapter 9, “Module 9. Customizing the default style,” on 

page 77. You have learned how to: 

v   Locate the existing style 

v   View the design of the existing style 

v   Edit the style sheet to include the company logo 

v   Edit PageBuilder.jsp to remove and resize fields for your logo 

v   Change the color

You have customized the default style to update the look and feel for a fictional 

company. Now you need to move the application into production and you need 

the WebFacing application to prompt the users for signon information when it 

starts. Continue to Chapter 10, “Module 10. Adding authentication,” on page 83. 
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Chapter  10.  Module  10.  Adding  authentication  

This module teaches you how to secure your application by forcing authentication 

before the application is invoked. 

In this module, you will: 

v   Start the Properties dialog 

v   Open the project run-time properties 

v   Change the signon properties for the order entry application 

v   Test the signon dialog appears

Exercises 

The exercises within this module must be completed in order: 

v   “Exercise 10.1: Removing the default user ID and password” 

v   “Exercise 10.2: Testing the authentication dialog” on page 85

Time  required 

This module will take approximately 5 minutes to complete. 

Exercise 10.1: Removing the default user ID and password 

You will use the CL command properties page of the runtime to remove the 

default user ID and password information. 

In the WebFacing perspective in the WebFacing project view: 

1.   Right-click wflabxx project. 

2.   Click Properties on the pop-up menu. 

The Properties for wflabxx dialog opens. 

3.   Under Run Time in the left pane of the Properties dialog, select Order Entry 

Application.
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The Order Entry application properties pane opens. 

  

  

4.   Make sure the Override project settings for this command check box is 

selected. 

5.   Uncheck the Specify OS/400® signon values check box. 

6.   Click OK at the bottom of the Properties dialog. 

You are back in the WebFacing Projects view. You have changed the 

authentication behavior for this link (application). In this WebFacing project 

you only have one link, but imagine that you have multiple entry points into 

your application like a menu. You could specify a different authentication 
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behavior for each of these links. On the other hand, if you have multiple links 

in a WebFacing project and the authentication should be the same for each 

different link, then you can specify an authentication rule on the project level. 

To do this, just go to the project properties page instead of the CL command 

properties page and specify the desired authentication behavior there.

You  have started the Properties dialog, opened the project run-time properties and 

changed the signon properties for the order entry application and now you are 

ready to begin “Exercise 10.2: Testing the authentication dialog.” 

Exercise 10.2: Testing  the authentication dialog 

Before you begin, you must complete “Exercise 10.1: Removing the default user ID 

and password” on page 83. 

As before, you run your application in the WebSphere Application Server test 

environment. 

To test the authentication dialog: 

1.   Right-click wflabxx project. 

2.   Click Run on Server on the pop-up menu. 

3.   Click the Order Entry link. 

You will see the authentication dialog. 

  

  

4.   Specify your User Name and Password. 

5.   Click the Logon push button on the Authentication dialog. 

The application will run like before, if the job environment for the user ID you 

specified is setup correct for this application. 

6.   If the LOGON dialog doesn’t appear, restart the Application server. 

a.   Click the Servers tab at the bottom view in the workbench. 

b.   Right-click the server icon.
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c.   Click Restart on the pop-up menu. 

d.   Run the application again.

You have tested that the signon dialog appears. 

Module recap 

You have completed Chapter 10, “Module 10. Adding authentication,” on page 83. 

You have learned how to: 

v   Start the Properties dialog 

v   Open the project run-time properties 

v   Change the signon properties for the order entry application 

v   Test the signon dialog appears

You  have created a WebFacing application and now want to enhance the look of 

the index.jsp page to give the start page of this application a professional 

appearance. The workbench contains several tools to design and enhance Web 

pages. Also with the workbench you have access to sample pictures, icons, 

animations, and more. You will use some of these tools and samples and enhance 

the page so it becomes more attractive. Continue to Chapter 11, “Module 11. 

Enhancing index.jsp page,” on page 87. 
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Chapter  11.  Module  11.  Enhancing  index.jsp  page  

This module teaches you how to use the Web tools in the workbench to update the 

index.jsp file. The index.jsp file created by the IBM WebFacing Tool that allows you 

to start your WebFacing application is plain. In this module you will add some 

color to it, as well as some pictures to make it a more interesting Web page. 

In this module, you will: 

v   Open the application start page (index.jsp) in Page Designer 

v   Change the window title to Order Entry 

v   Add a style to the Order Entry Web page 

v   Start WebArt Designer 

v   Add a logo 

v   Resize the logo 

v   Save the logo as a WebArt object 

v   Save the logo for a Web page 

v   Place the logo on the Design page 

v   Insert a heading below the logo 

v   Add a picture to the Order Entry Web page 

v   Add a marquee to the Order Entry Web page 

v   Change the color of the window title 

v   Remove default text added by the WebFacing Tool

Exercises 

The exercises within this module must be completed in order. 

v   “Exercise 11.1: Opening Page Designer” 

v   “Exercise 11.2: Working with page properties” on page 88 

v   “Exercise 11.3: Linking a cascading style sheet to a Web page” on page 90 

v   “Exercise 11.4: Designing and adding a logo” on page 91 

v   “Exercise 11.5: Adding a heading 1 tag to the page” on page 100 

v   “Exercise 11.6: Adding a picture to the page” on page 102 

v   “Exercise 11.7: Adding moving text to the page” on page 103 

v   “Exercise 11.8: Changing the text color” on page 106 

v   “Exercise 11.9: Deleting default text from the page” on page 107

Time  required 

This module will take approximately 30 minutes to complete. 

Exercise 11.1: Opening Page Designer 

To open Page Designer: 

1.   Open the WebFacing perspective, if not already open. 

You should now have the WebFacing Projects view in your workbench 

environment.
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2.   Expand the wflabxx WebFacing project. 

3.   Right-click the index.jsp icon. 

4.   Click Open on the pop-up menu. 

The Page Designer opens in the upper right pane of the workbench and shows 

the index.jsp page as the WebFacing Tool created it.
  

 

Make sure that you are on the Design page in Page Designer. 

5.   Click the Design tab.

You have opened the application start page (index.jsp) in Page Designer and you 

are ready to begin “Exercise 11.2: Working with page properties.” 

Exercise 11.2: Working  with page properties 

Before you begin, you must complete “Exercise 11.1: Opening Page Designer” on 

page 87. 

Next you move the links down. 

To work with page properties: 

1.   Click before the Select program to start title. 

2.   Press the Enter key a number of times. 
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3.   Right-click the background of the index.jsp page in Page Designer. 

4.   Click Page Properties on the pop-up menu.
  

 

The Page Properties dialog opens.
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5.   In the Page title field, type Order Entry. 

6.   Click OK on the Page Properties dialog. 

When this page is shown in a browser, the Window title bar of the browser will 

now display Order Entry.

You have changed the window title to Order Entry and now you are ready to 

begin “Exercise 11.3: Linking a cascading style sheet to a Web page.” 

Exercise 11.3: Linking a cascading style sheet to a Web  page 

Before you begin, you must complete “Exercise 11.2: Working with page 

properties” on page 88. 

Now you will add a style to the Web page. You can use a style that is used in your 

company or you can use one of the sample style sheets that are provided in the 

product. 

Next you open the Gallery view in the workbench. 

To link a style sheet:
  

  

1.   Click the Gallery tab, if the Gallery view isn’t already displayed. 

2.   Scroll to the bottom of the Gallery view, until you can see the Style Sheet icon. 

3.   Click the Style Sheet icon, to select it. 

4.   Click the Thumbnails tab on the right bottom pane in the workbench. 

You should see thumbnail icons of all the styles available. 

5.   In the thumbnail view, scroll down to the bottom, until you see style sheet 

waves001.css in the list, or select a style sheet that you like best. 

6.   Click the thumbnail picture of waves001.css with the left mouse button. 

7.   Hold the left mouse button down and drag the cursor to the Page Designer 

window. 
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8.   The cursor will change from this shape 

   

, to this shape 

  

. When the 

latter cursor shape appears in the Page Designer window, release the left mouse 

button. 

After a short while the Style sheet properties will be applied and the colors in 

the page will change to the style sheet definitions.
  

 

You have added a style to the Order Entry Web page and now you are ready to 

begin “Exercise 11.4: Designing and adding a logo.” 

Exercise 11.4: Designing and adding a logo 

Before you begin, you must complete “Exercise 11.3: Linking a cascading style 

sheet to a Web page” on page 90. 

Now that you have the overall Web page look specified, you will use the WebArt 

Designer to create a Logo that you then will add to this page. 

Starting the WebArt Designer 

To start the WebArt Designer: 

  

  

1.   Click Tools in the workbench menu. 

2.   Click WebArt Designer on the pop-up menu. 

The WebArt Designer opens.
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The WebArt Designer shows the Template Gallery on the left, where you find 

samples of logos, buttons, rollovers, images and more. The big white area in 

middle of the dialog is the canvas that is used to work with objects that you 

want to create or change. Although you could select a logo from the template 

gallery as the base for your own logo, you will instead create you own.

Creating the logo 

To create the logo: 

 1.   Click the Create Logo button above the canvas or use the Object > Create 

Logo menu options. 

  

 

The Logo Wizard opens. 
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2.   Enter your company name in the Text field and in the next line of the Text 

field enter the project name. 

 3.   Select Comic Sans MS in the Font name list. 

 4.   Select 46 in the Font size list. 

 5.   Under Style, select Bold and Italic check boxes. 

 6.   Leave the Antialias check box selected. 

 7.   Click the Center radio button under Alignment. 

Notice in the upper right corner of the dialog, a sample of the logo is 

displayed. 

 8.   Click Next to go to the next page of the wizard. 

The Select Color page of the wizard opens.
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9.   Click the gradation Type push button, the middle one of the three type push 

buttons.

Note:  The other push buttons select color types: solid and textured. 

10.   Select beer from the colors available, or any other color you like best, just 

scroll through the list to find a gradation you like. 

Tip: You can change the colors by clicking the Others push button on this 

dialog and create your own gradation. 

11.   Click Next to move forward to the next page. 

The Select Outline page opens. 
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12.   Select the Seal outline from the list, or any outline you like best. 

13.   Click Next. 

The Select Text Effect page opens.
  

  

14.   Select the Emboss text effect or one that you like best. 

15.   Click Finish. 

You return to the WebArt Designer window with the new logo object.
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Resizing the logo 

To resize the logo object on the canvas: 

1.   Click the logo object to select it. 

2.   Move the cursor to the rectangle at the right bottom corners of the object, 

watch the cursor changing shape. 

3.   Drag the rectangle up and to the left so the object becomes smaller. 

Now you need to save this object. First you want save it as a WebArt object, 

that allows you later on to work with the object again in WebArt Designer. 

However you can’t use that format for your Web page, so you will also save it 

in another format.

Saving the logo as a WebArt object 

To save the logo as a WebArt object: 

1.   Click File on the WebArt Designer menu. 

2.   Click Save Canvas As on the pop-up menu. 

The Save Canvas As dialog opens. 

Note:  Make sure you save the canvas in your workspace. 
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3.   Type mylogo in the File name field. 

4.   Click Save. 

Now you save the object in a form that can be displayed on a Web page.

Saving the object for a Web page 

To save the logo object for a Web page: 

 1.   Click File from the WebArt Designer menu again. 

 2.   Click Save Wizard for Web on the pop-up menu. 

The Save Wizard dialog opens.
  

  

 3.   Leave the Save the selected objects radio button selected. 

 4.   Click Next. 

Now the Select File format page opens.
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5.   Leave the GIF radio button selected. 

 6.   Click Next. 

The GIF Format page opens.
  

  

 7.   Click Finish. 
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The Save As dialog opens.
  

  

 8.   Type mylogo in the File name field. 

 9.   Click Save. 

Next you close the WebArt Designer. 

10.   Click File from the menu. 

11.   Click Exit on the pop-up menu. 

You are back in the workbench in the WebFacing perspective showing the 

WebFacing Projects view. 

Next you switch to the Navigator view to locate the logo object mylogo.gif 

and to place the logo on the Design page.

Note:  You may have to click Window > Show view > Navigator from the 

workbench menu.

Placing the logo on the Design page 

To place the logo on the Design page: 

1.   Click the Navigator tab. 

2.   Expand the wflabxx Web project if not already expanded. 

3.   Expand the WebContent folder if not already expanded.
  

 

The mylogo.gif file should appear in the list. If it doesn’t appear, refresh the 

list. 
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4.   Right-click the WebContent folder icon. 

5.   Click Refresh on the pop-up menu. 

Hopefully you can see the file now in the Web Content folder; if not, go to 

Windows Explorer and search for the mylogo.gif on your hard drive. Move it 

to the Web Content folder in the product workspace. If you didn’t use the 

default workspace location, do a search for the workspace and the wflabxx 

directory in it. Move the mylogo.gif into the WebContent directory under the 

wflabxx directory. Refresh the Navigator view again. 

Now you can take the logo and put it on your Web page that is still open in 

Page Designer. If Page Designer has been closed just open the index.jsp file. 

Make sure you are on the Design page, not the Preview page. 

6.   In the Navigator view, select the mylogo.gif file. 

7.   Hold the left mouse down. 

8.   Drag the file to the upper left corner in the Page Designer window. 

9.   Release the mouse button. 

The logo is placed on the Design page. 

  

 

You have started WebArt Designer, added a logo, resized the logo, saved the logo, 

and placed the logo on the Design page, and now you are ready to “Exercise 11.5: 

Adding a heading 1 tag to the page.” 

Exercise 11.5: Adding a heading 1 tag to the page 

Before you begin, you must complete “Exercise 11.4: Designing and adding a logo” 

on page 91. 

Now you want to insert a heading below the logo. 

To add a heading 1 tag: 

1.   Position the cursor just below the Logo at the first BR tag.
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2.   Click Insert from the workbench menu. 

3.   Click Paragraph > Heading 1 on the pop-up menu. 

A frame appears that allows you to enter text. 

4.   Enter your company name Order Entry Application.
  

 

Now you want to use one of the sample pictures included with the product 

and place this picture on the page.

You have inserted a heading below the logo and now you are ready to begin 

“Exercise 11.6: Adding a picture to the page” on page 102. 
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Exercise 11.6: Adding a picture to the page 

Before you begin, you must complete “Exercise 11.5: Adding a heading 1 tag to the 

page” on page 100. 

To add a picture to the page: 

  

  

1.   In the workbench in the Navigator view, select the Gallery tab. 

2.   Expand the Image folder. 

3.   Select the Illustration folder. 

4.   In the Thumbnails view beside the Gallery view, select one of the sample 

illustrations, for example, use file 005il.gif.

Note:  The sample illustrations change from release to release so 005il.gif might 

not be available in your environment. 

5.   Drag a picture onto the Design page below the heading. 

The Design page now contains a picture.
  

 

You are almost done. Next you add moving text to the page.

You  have added a picture to the Order Entry Web page and now you are ready to 

begin “Exercise 11.7: Adding moving text to the page” on page 103. 
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Exercise 11.7: Adding moving text to the page 

Before you begin, you must complete “Exercise 11.6: Adding a picture to the page” 

on page 102. 

Now you add moving text to the page. 

To add moving text: 

 1.   Position the cursor in the Design page underneath the picture. 

 2.   Click Insert from the workbench menu. 

 3.   Click Paragraph > Heading 3 on the pop-up menu.
  

  

 4.   Leave the cursor positioned inside the heading 3 frame.
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5.   Click Insert from the workbench menu. 

 6.   Click Others > Marquee on the pop-up menu. 

The Insert Marquee dialog opens.
  

  

 7.   Enter into the Text field, Please select link to start application. 

 8.   Under Behavior, select Slide in the Movement list. 

 9.   Under Repetition, select Finite in the Repetition list. 

10.   Under Repetition, type 1 in the Count field. 
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The two last selections just avoid the text sliding in forever and not standing 

still. If you want more movement on the page you can change these settings. 

11.   Select Lime in the Background color list. Click OK on the Color palette. 

12.   Click OK on the Insert Marquee dialog. 

The Design page should look like.
  

 

Next you save some space by removing some of the line break tags. 

13.   Position the cursor on the BR tag. 

14.   Press the Delete key until the SELECT PROGRAM TO START title appears on 

your page.
  

 

Next you look at the page, as it would appear in a browser. 

15.   Click the Preview tab at the bottom of the Design page. 

You will notice that your heading 3 text is sliding in. 
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You have added a marquee to the Order Entry Web page and now you are ready 

to begin “Exercise 11.8: Changing the text color.” 

Exercise 11.8: Changing the text color 

Before you begin, you must complete “Exercise 11.7: Adding moving text to the 

page” on page 103. 

You notice that the Text color and the background are not easy to distinguish from 

each other. One way of changing this, is to apply another color to a certain area of 

the text. To do that you return to the Design page. 

To change the text color: 

1.   Click the Design tab.
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2.   Select the company text (IBM) you want to change color on, by selecting the 

text area with the mouse cursor. 

3.   Under the Design page, select the Colors tab. 

4.   In the Colors view, select a color with your mouse cursor. 

5.   Click the down arrow next to the Text Color from the Colors view. 

6.   Click Set as Text Color on the pop-up menu. 

You are done; now the selected text will be displayed with the color you 

selected for it.

You have changed the color of the window title and now you are ready to begin 

“Exercise 11.9: Deleting default text from the page.” 

Exercise 11.9: Deleting default text from the page 

Before you begin, you must complete “Exercise 11.8: Changing the text color” on 

page 106. 

Now you want to remove the default text that was added by the WebFacing Tool. 

To delete default text from the page:
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1.   Select the text. 

2.   Press the Delete key. 

3.   Select the Preview tab to view your completed page. 

  

  

4.   Close the file index.jsp. 

5.   Click Yes to save the changes. 

Page Designer is closed. 

6.   In the Navigator view or WebFacing Projects view, right-click wflabxx. 

7.   Click Run on Server on the pop-up menu. 

Your new designed index.jsp page opens and you can run your application.
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You have removed the default text added by the WebFacing Tool. 

Module recap 

You have completed Chapter 11, “Module 11. Enhancing index.jsp page,” on page 

87. You have learned how to: 

v   Open the application start page (index.jsp) in Page Designer 

v   Change the window title to Order Entry 

v   Add a style to the Order Entry Web page 

v   Start WebArt Designer 

v   Add a logo 

v   Resize the logo 

v   Save the logo as a WebArt object 

v   Save the logo for a Web page 

v   Place the logo on the Design page 

v   Insert a heading below the logo 

v   Add a picture to the Order Entry Web page 

v   Add a marquee to the Order Entry Web page 

v   Change the color of the window title 

v   Remove default text added by the WebFacing Tool

After creating and testing your completed WebFacing application, you can deploy 

the WebFacing application, if you have WebSphere Application Server Express 

installed on your iSeries server. If you want to deploy your WebFacing application, 

continue to Chapter 12, “Module 12. (Optional) Exporting to iSeries WebSphere 

Application Server Express 5.1,” on page 111.  
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Chapter  12.  Module  12.  (Optional)  Exporting  to iSeries  

WebSphere  Application  Server  Express  5.1  

You have tested the WebFacing application in the WebSphere Application Server 

test environment and you are ready to move it to your iSeries WebSphere 

Application Server production environment. You are running WebSphere 

Application Server Express Version 5.1 on your iSeries server. 

This module teaches you how to publish your WebFacing files to a remote 

WebSphere Application Server Express 5.1 environment on an iSeries host. In this 

module, you will learn how to: 

v   Map a network drive 

v   Open the Export wizard 

v   Export the EAR file 

v   Start an existing HTTP server console 

v   Install and manage the application 

v   Run the application on the production server

Exercises 

The exercises within this module must be completed in order: 

v   “Exercise 12.1: Mapping a network drive” 

v   “Exercise 12.2: Exporting your EAR file” on page 112 

v   “Exercise 12.3: Installing the application” on page 114 

v   “Exercise 12.4: Testing the WebFacing application” on page 119

Time  required 

This module will take approximately 30 minutes to complete. 

Exercise 12.1: Mapping a network drive 

First you copy the WebFacing project files to a WebSphere Application Server, 

Version 5.1. These first steps are the same for WebSphere Application Server for 

iSeries, Version 5.1 and the WebSphere Application Server for iSeries Express, 

Version 5.1. 

Before you export any files, you must map a network drive to the Root file system 

on the iSeries where WebSphere Application Server is installed. 

To map a network drive: 

1.   Right-click the Network Neighborhood or (My Network Places) icon on the 

desktop. 

2.   Select Map  Network drive on the pop-up menu. 

The Map Network Drive dialog opens. 
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3.   In the Folder field, enter two backslashes \\ and the Netserver name of your 

Web server, and then \QIBM, for example: \\S400A\QIBM. 

4.   Click Finish. 

You now have an additional drive available on your workstation and are ready 

to export your WebFacing project files.

You have mapped a network drive and opened the Export wizard and now you 

are ready to begin “Exercise 12.2: Exporting your EAR file.” 

Exercise 12.2: Exporting your EAR file 

Before you begin, you must complete “Exercise 12.1: Mapping a network drive” on 

page 111.  

The J2EE standard has the concept of an Enterprise Archive File (EAR). This file is 

a zip file that contains all information about your Web application. In the 

workbench, this file is built automatically for Web projects. Since your WebFacing 

project is a Web project, the wflabxxEAR file exists already. You only have to move 

it to the application server, point to it, and then install the application. There is no 

need to know about the structure of the application. Everything is handled in the 

workbench. Return to the workbench. 

To export your EAR file: 

1.   In the WebFacing perspective, click File from the workbench menu. 

2.   Click Export on the pop-up menu. 

The Select page of the Export wizard opens. 
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3.   Select the EAR file icon. 

An EAR file is a compressed Enterprise Application Archive, and it contains all 

the files needed for the Web application. 

4.   Click Next. 

The EAR Export page opens. 
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5.   Select the name of the resources you used when creating your WebFacing 

project. This should be wflabxxEAR from the Enterprise Application project 

name list. 

6.   In the Destination field, specify where you want to put the EAR file by 

entering the drive and directory structure of the IFS drive you mapped in the 

steps before. For example, use the default directory structure for installable 

applications for WebSphere Application Server Express: 

x:\QIBM\UserData\WebASE51\ASE\SV51Epr\installableApps\wflabxx.ear 

where x: is the drive letter mapped from your iSeries host in the previous 

steps. 

7.   Select the Overwrite existing files without warning check box. 

8.   Click Finish. 

If you see a message asking you to create a directory or delete an existing file, 

Click OK or Yes and continue. Now you can install the application in 

WebSphere Application Server.

You have exported the EAR file and now you are ready to begin “Exercise 12.3: 

Installing the application.” 

Exercise 12.3: Installing the application 

Before you begin, you must complete “Exercise 12.2: Exporting your EAR file” on 

page 112. 

At this point, you already need to have set up and started the WebSphere 

Application Server and an associated HTTP server on your iSeries server. You also 
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need to find the port number of the HTTP servers Administrative Console (referred 

to as port#a) and the port number to run your application (referred to as port#b) 

The second one is the port number of your HTTP server that is set up to work 

with your application server. 

To install the application: 

 1.   Open any Web browser and type: http://servername:port#a/ in the Address 

field. 

Note:  The default administrative port number for the HTTP server is 2001. 

The Login dialog appears. 

 2.   Type your iSeries user ID in the user ID field. 

 3.   Type your iSeries password in the password field. 

 4.   Click OK. 

The browser opens.
  

  

 5.   Click IBM HTTP Server for iSeries from the iSeries Tasks menu. 

The Administration pages for the HTTP and application servers display. 

 6.   Select the Manage Tab. 

The Manage Application Server – Express page displays. 
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7.   Select your WebSphere Application Server Express server instance from the 

Server list. 

 8.   Click Install New Application under the WAS Wizards list. 

The Install New Application page displays. 

  

  

 9.   Click the Application is contained in an EAR file radio button. 

10.   Specify the location of your EAR file; (the file that you exported in the 

previous step). 

You can use the Browse push button to locate the file. 

11.   Click Next. 

A page appears with options for application installation. 
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12.   In the Application name field, type wflabxx. 

13.   You can select the Pre-compile JSPs check box to speed up the process of 

showing the page the first time. (JSPs are compiled into Servlets when first 

generated.) 

14.   Click Next. 

The Map Virtual Hosts Page appears. 

  

  

15.   Select the virtual host to be associated with the Web module. 

16.   Select a virtual host of your choice, or leave the default host selected. 

17.   Click Next. 

The application summary page displays. 

  

  

18.   Click Finish. 

After the successful installation you see a page where you can manage the 

installed applications. 

 

Chapter  12.  Module  12. (Optional) Exporting  to iSeries WebSphere  Application Server Express 5.1 117



19.   Click Manage Installed Applications under Applications. 

A page with the installed applications displays. 

  

  

20.   Click the wflabxx radio button in the list of installed applications. 

21.   If the wflabxx application is disabled, click the Properties push button to 

enable the application.
  

  

22.   Select Enabled from the Application enablement list. 

23.   Click OK. 

Next you start the application with wflabxx in the enabled state.
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24.   Click the wflabxx radio button. 

25.   Click Start. 

If the Start button is not enabled, start the server first. 

Now you are ready to test your WebFacing application.

You  have started the existing HTTP server, installed and managed the application 

and now you are ready to begin “Exercise 12.4: Testing the WebFacing 

application.” 

Exercise 12.4: Testing  the WebFacing  application 

Before you begin, you must complete “Exercise 12.3: Installing the application” on 

page 114. 

To test the Web application: 

1.   Open the Internet Explorer and type Http://servername:port#b/wflabxx in the 

Address field. 

Note:  This is the HTTP port name, most likely 80, not the application bootstrap 

port. 

Your application index.jsp page should open. If it does not, double-check the 

URL and the port number. Also try restarting the HTTP server and the 

application server. Refer to the Administrative Console Web site if you are 

having problems starting and running the HTTP server or the WebSphere 

Application Server. If you still encounter problems, there are troubleshooting 

guides, FAQs, and newsgroups on the Web where you can find an explanation 

of your situation with more detailed information.

You  have run the application. 

Module recap 

You have completed Chapter 12, “Module 12. (Optional) Exporting to iSeries 

WebSphere Application Server Express 5.1,” on page 111.  You have learned how to: 

v   Map a network drive 

v   Open the Export wizard 

v   Export the EAR file 

v   Start an existing HTTP server console 

v   Install and manage the application 
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v   Run the application on the production server

Finish your tutorial by reviewing the materials in Chapter 13, “Summary,” on page 

121. 
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Chapter  13.  Summary  

This tutorial has taught you how to convert the DDS screens in an existing 5250 

order entry application to a Web browser user interface. While creating a browser 

user interface, you learned how to use the IBM WebFacing Tool. You also learned 

how to customize the output of the conversion process using the IBM WebFacing 

Tool and the CODE Designer. Finally, you learned how to run the WebFacing 

application in the WebSphere Test Environment that is part of the product. 

If you have completed all of the modules, you should now be able to: 

v   Create a WebFacing Web Project 

v   Convert one or more DDS and UIM files 

v   Run the application in the WebSphere Test Environment 

v   Change certain aspects of the user interface related to the conversion process 

v   Create a new style of the Web user interface 

v   Add your own command key rules to the WebFacing conversion properties 

v   Apply more style properties to the Web user interface 

v   Customize the WebFacing application style 

v   Secure your application by forcing authentication before the application is called 

v   Make the input page of the application more interesting 

v   Deploy the WebFacing application to a production server (optional)

More information 

For more information on the product and the IBM WebFacing Tool, see 

http://ibm.com/software/adwtools/iseries. 
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Appendix.  Notices  

Note to U.S. Government Users Restricted Rights — Use, duplication or disclosure 

restricted by GSA ADP Schedule Contract with IBM Corp. 

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in 

other countries. Consult your local IBM representative for information on the 

products and services currently available in your area. Any reference to an IBM 

product, program, or service is not intended to state or imply that only that IBM 

product, program, or service may be used. Any functionally equivalent product, 

program, or service that does not infringe any IBM intellectual property right may 

be used instead. However, it is the user’s responsibility to evaluate and verify the 

operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter 

described in this document. The furnishing of this document does not give you 

any license to these patents. You can send license inquiries, in writing, to: 

IBM Director of Licensing 

IBM Corporation 

North Castle Drive 

Armonk, NY 10504-1785 

U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM 

Intellectual Property Department in your country or send inquiries, in writing, to:

IBM  World Trade Asia Corporation 

Licensing 

2-31 Roppongi 3-chome, Minato-ku 

Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other 

country where such provisions are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 

PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER 

EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS 

FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or 

implied warranties in certain transactions, therefore, this statement may not apply 

to you. 

This information could include technical inaccuracies or typographical errors. 

Changes are periodically made to the information herein; these changes will be 

incorporated in new editions of the publication. IBM may make improvements 

and/or changes in the product(s) and/or the program(s) described in this 

publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for 

convenience only and do not in any manner serve as an endorsement of those Web 

sites. The materials at those Web sites are not part of the materials for this IBM 

product and use of those Web sites is at your own risk. 
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IBM may use or distribute any of the information you supply in any way it 

believes appropriate without incurring any obligation to you. 

Licensees of this program who wish to have information about it for the purpose 

of enabling: (i) the exchange of information between independently created 

programs and other programs (including this one) and (ii) the mutual use of the 

information which has been exchanged, should contact: 

Lab Director 

IBM Canada Ltd. Laboratory 

8200 Warden Avenue 

Markham, Ontario 

Canada 

L6G 1C7

Such information may be available, subject to appropriate terms and conditions, 

including in some cases, payment of a fee. 

The licensed program described in this information and all licensed material 

available for it are provided by IBM under terms of the IBM Customer Agreement, 

IBM International Program License Agreement, or any equivalent agreement 

between us. 

Information concerning non-IBM products was obtained from the suppliers of 

those products, their published announcements or other publicly available sources. 

IBM has not tested those products and cannot confirm the accuracy of 

performance, compatibility or any other claims related to non-IBM products. 

Questions on the capabilities of non-IBM products should be addressed to the 

suppliers of those products. 

This information contains examples of data and reports used in daily business 

operations. To illustrate them as completely as possible, the examples include the 

names of individuals, companies, brands, and products. All of these names are 

fictitious and any similarity to the names and addresses used by an actual business 

enterprise is entirely coincidental. 

COPYRIGHT LICENSE: 

Each copy or any portion of these sample programs or any derivative work, must 

include a copyright notice as follows: 

© (your company name) (year). Portions of this code are derived from IBM Corp. 

Sample Programs. © Copyright IBM Corp. 1992, 2004. All rights reserved. 

If you are viewing this information softcopy, the photographs and color 

illustrations may not appear. 

Programming interface information 

Programming interface information is intended to help you create application 

software using this program. 

General-use programming interfaces allow you to write application software that 

obtain the services of this program’s tools. 
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However, this information may also contain diagnosis, modification, and tuning 

information. Diagnosis, modification and tuning information is provided to help 

you debug your application software. 

Warning: Do not use this diagnosis, modification, and tuning information as a 

programming interface because it is subject to change. 

Trademarks  

CUA 

IBM 

iSeries 

OS/400 

RPG/400 

VisualAge 

WebSphere 

 Java and all Java-based trademarks and logos are trademarks or registered 

trademarks of Sun Microsystems, Inc. in the United States, other countries, or both. 

ActiveX, Microsoft, SourceSafe, Visual C++, Visual SourceSafe, Windows, Windows 

NT®, Win32, Win32s and the Windows logo are trademarks of Microsoft 

Corporation in the United States, other countries, or both. 

UNIX® is a registered trademark of The Open Group. 

Other company, product, and service names may be trademarks or service marks 

of others.
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